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RESUMEN

Esta monografia esta enfocada especificamente a estudio de “Eclipse’, una herramienta
de cddigo abierto (software distribuido y desarrollado libremente), que provee una
plataforma de desarrollo y aplicaciones framework para la construccion de software.
Eclipse es utilizado como editor de codigo para algunos lenguajes de programacion,
entre ellos Java.

Framework es una estructura de soporte definida en la cua un proyecto de software
puede ser organizado y desarrollado. Un framework puede incluir soporte de programas,
bibliotecas y un lenguaje de scripting, entre otros, para ayudar a desarrollar y unir los
diferentes componentes de un proyecto, representando una arquitectura que modela las
relaciones generales de las entidades del dominio.
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ABSTRACT

This Project is about Eclipse, an open source (software developed and distributed as
free) tool, focused on providing a devel opment platform and application frameworks for
building software. Eclipse is used as an open source editor, for writing code in some
programming languages one of them Java.

Framework is a defined support structure in which another software project can be
organized and developed. A framework may include support programs, code libraries, a
scripting language, or other software to help develop and glue together the different
components of a software project. Frameworks are designed with the intent of
facilitating software development, by allowing designers and programmers to spend
more time on meeting software requirements rather than dealing with the more tedious
low level details of providing aworking system.
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INTRODUCCION

En la época actual lo fundamental en e desarrollo de aplicaciones es mangjar una
Ingenieria de Software que brinde a los usuarios calidad, es por eso que los frameworks
se han convertido en la base de la Ingenieria de Software. El uso de los mismos esta
ganando rapidamente la aceptacion debido a que permite la reutilizacién del codigo del
disefio y e codigo fuente.

El codigo abierto da la facilidad de aprender de ensefiar de competir, dandonos libertad
de expresién y de eleccion, representando en las empresas una disminucion considerable
en |los costos de cualquiera de sus proyectos.

Los frameworks permiten la reutilizacion tanto del codigo del disefio como e codigo
fuente.

Eclipse es una herramienta Framework OpenSource, es una estructura (workbench)
sobre la que se pueden montar herramientas de desarrollo para cualquier lenguaje,
mediante laimplementacién de los plugins adecuados.

La arquitectura de plugins de Eclipse permite, ademés de integrar diversos lenguajes
sobre un mismo IDE, introducir otras aplicaciones accesorias que pueden resultar Gtiles
durante el proceso de desarrollo como: herramientas UML, editores visuaes de
interfaces, ayuda en linea paralibrerias, etc.
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CAPITULO1

OPEN SOURCE AND FRAMEWORK

1.1. Introduccién

OPEN SOURCE (cédigo abierto), es todo software que se encuentra distribuido y
desarrollado libremente.

Empezaron a utilizar este término algunos usuarios de la comunidad del software libre
en 1998, se trat6 de utilizarlo en vez del nombre origina que estaba en ingles del
software libre (free software).

Al decir Free se puede pensar en un software por el que no hay gque pagar, es decir
software gratuito y, por otro lado se puede pensar en un software que posee ciertas
libertades.

Traduciendo Literalmente el significado de open source es que se puede mirar €l codigo
fuente. Por eso se dice que un programa de cédigo abierto puede ser software libre,
semilibre o no libre. Pero cas siempre un programa de cédigo abierto puede ser y de
hecho es software libre, como igualmente un programa Software Libre es Open Source.

1.1.1 Definicion

" Open Source" se refiere a tener acceso a codigo fuente, este ofrece la libertad de
aprender, libertad de ensefiar, libertad de competir, libertad de expresion y libertad de
eleccion, ademas que estas representan una disminucion considerable en los costos de
cualquier proyecto empresarial.

A continuacién aclaramos ciertos términos;

Softwar e libre (fr ee softwar e)

Software que, una vez obtenido, puede ser usado, copiado, estudiado, modificado y
redistribuido libremente. El software libre suele estar disponible gratuitamente en
Internet, o a precio del coste de la distribucién a través de otros medios; sin embargo no
es obligatorio que sea asi y, aunque conserve su carécter de libre, puede ser vendido
comercia mente.

Softwar e de dominio publico

Es aguél por e gue no es necesario solicitar ninguna licencia y cuyos derechos de
explotacion son para toda la humanidad, porque pertenece a todos por igual. Cualquiera
puede hacer uso de él, siempre con fines legales y consignando su autoria original. Este
software seria aquél cuyo autor lo dona a la humanidad o cuyos derechos de autor han
expirado.
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Softwar e semilibre

Es una categoria de programas informéaticos que no son libres, pero que vienen con
autorizacion de uso, copia, modificacion y redistribucion (incluso de versiones
modificadas) sin fines de lucro (PGP seria un giemplo de un programa semilibre).

Softwareno libre

También llamado software propietario, software privativo, software privado, software
con propietario o software de propiedad) se refiere a cualquier programainformético en
el que los usuarios tienen limitadas las posibilidades de usarlo, modificarlo o
redistribuirlo (con o sin modificaciones), o cuyo codigo fuente no esta disponible o €l
acceso a éste se encuentrarestringido .

Licencia Open Source

Una licencia open-source es una licencia que se usa para programas de computadoras,
con copyright, que siguen los principios del movimiento Open Source.

Una licencia es considerada Open Source cuando ha sido aprobada por la Open Source
Initiative (OSI), donde € criterio lo da la definicion de Open Source. El software de
dominio publico (esto significa sin licencia), cumple todos estos criterios siempre y
cuando todo el codigo fuente esté disponible, y esté reconocido por la OSl y se le
permita usar la marca de la misma.

La Open Source Initiative utiliza la Definicion de Open Source para determinar si una
licencia de software de computadora puede o no considerarse software abierto. Es
similar pero no igual aladefinicién de licencia de software libre.

Bajo la Definicién Open Source, las licencias deben cumplir diez condiciones para ser
consideradas licencias de software abierto:

Libre redistribucion: el software debe poder ser regalado o vendido libremente.
Cadigo fuente: el codigo fuente debe estar incluido u obtenerse libremente.
Trabajos derivados: |a redistribucion de modificaciones debe estar permitida.
Integridad del cdédigo fuente del autor: las licencias pueden requerir que las
modificaciones sean redistribuidas solo como parches.

Sin discriminacion de personas 0 grupos: hadie puede dejarse fuera.

Sin discriminacion de areas de iniciativa: |os usuarios comerciales no pueden ser
excluidos.

7. Distribucion de la licencia: deben aplicarse los mismos derechos a todo e que
reciba el programa.

pODNPRE

o o
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8. La licencia no debe ser especifica de un producto: € programa no puede
licenciarse solo como parte de una distribucion mayor.

9. Lalicencia no debe restringir otro software: la licencia no puede obligar a que
algun otro software que sea distribuido con el software abierto deba también ser
de codigo abierto.

10. Lalicencia debe ser tecnol 6gicamente neutral: no debe requerirse la aceptacion
de la licencia por medio de un acceso por click de ratbn o de otra forma
especifica del medio de soporte del software.

1. 1.2 Ventajas SoftwareLibre

e El término "Open Source" se refiere atener acceso a cddigo fuente. Pero
el acceso a codigo fuente es apenas un pre-requisito para dos de las cuatro
libertades que definen a Software Libre. Muchas personas no entienden
que & acceso a codigo fuente no es suficiente.

e Desafortunadamente, muchas compafiias han comenzado a Illamar sus
productos "Open Source" cuando algunas partes del cédigo son visibles.
Los usuarios compran este software creyendo que estén adquiriendo algo
"tan bueno como GNU/Linux" ya que se supone sigue los mismos
principios.

No debemos permitir que los vendedores de software propio abusen de las
personas de esta forma.

El Software Libre ofrecelibertad
El Software Libre proporcionalalibertad de:

. Ejecutar € programa, para cualquier propdsito;

. Estudiar € funcionamiento del programa, y adaptarlo a sus necesidades;

. Redistribuir copias;

. Mejorar el programa, y poner sus mejoras a disposicion del publico, para
beneficio de toda la comunidad.

La definicién de software libre dada por la "Free Software Foundation™, con sus cuatro
libertades, es la definicién mas clara que existe actualmente.

Como consecuencia de estas 4 libertades, el Software Libre ofrece la libertad de
aprender, libertad de ensefiar, libertad de competir, libertad de expresion y libertad de
eleccion. Ademés que estas representan una disminucién considerable en los costos de
cualquier proyecto empresarial.
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1.2 FRAMEWORK

1.2.1 Introduccién

En el desarrollo de software, un framework es una estructura de soporte definida en la
cual otro proyecto de software puede ser organizado y desarrollado. Tipicamente, un
framework puede incluir soporte de programas, bibliotecas y un lenguaje de scripting
entre otros softwares para ayudar a desarrollar y unir los diferentes componentes de un
proyecto.

Los lenguajes interpretados (0 lenguajes de script) forman un subconjunto de los
lenguajes de programacion, que incluye a aguellos lenguajes cuyos programas son
habitual mente gjecutados en un intérprete en vez de compilados.

1.2.2 Definicién

Un framework representa una arquitectura de software que modela las relaciones
generales de las entidades del dominio. Provee una estructura y una metodologia de
trabgjo la cual extiende o utiliza las aplicaciones del dominio.

En la época actual lo fundamental en el desarrollo de aplicaciones es mangjar una
Ingenieria de Software que brinde a los usuarios calidad, es por eso que los frameworks
se han convertido en la base de la Ingenieria de Software. El uso de los mismos esta
ganando rapidamente la aceptacion debido a que permite la reutilizacion del codigo del
disefio y e codigo fuente.

1.2.3 Importanciadeun Framework (Utilidades)

e Paranoiniciar € proyecto desdecero, cuando lo que se quiere es ganar
velocidad en el desarrollo.

e Da tranquilidad en el soporte de labase de la aplicacion, se dispone
de suficiente documentacion.

e [Existen patrones de programacién, estructura, desarrollo y
mantenimiento del codigo generado

e Disponer de lo mejor de cada plataforma dedesarrollo da una sensacion
y seguridad de un proyecto prosperoy bien hecho.
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1.2.4 Ventajas

¢ Disponen de conectores a las bases de datos mas conocidas

e Laseguridad del proyecto resultante estaavaladapor terceras personas que
en realidad son miembros de la misma comunidad.

e Caracteristicas multilenguaje y multicultura

e Disponen de mecanismos de autenticacion variadosy funcionales

e Son tolerantes afallos propios o inducidos.

e Gracias a la documentacion su curva de aprendizaje es muy buena.

¢ Disponen de excelentes herramientas para crear formularios haciendo fécil laca
ptura de datos y manejo de errores inducidos por €llos.

1.2.5 CONCLUSION

OpenSource nos da lafacilidad de aprender de ensefiar de competir, dandonos libertad
de expresién y de eleccion, representando en las empresas una disminucion considerable
en |los costos de cualquiera de sus proyectos.

Frameworks son la base de la Ingenieria de Software, 10 que nos lleva a la rgpida
aceptacion, porque permite la reutilizacion tanto del codigo del disefio como el codigo
fuente. A la vez tiene la capacidad de separar LaFuncionalidad, LosDatos, Yy
L a Presentacion.
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Java
CAPITULO 2
JAVA
2.1 Introduccion

Java hizo su aparicion en 1991 cuando un grupo de Ingenieros de Sun Microsystems
trataron de disefiar un nuevo lenguaje de programacion destinado a computadores, cuya
reducida potencia de calculo y memoria los llevé a desarrollar un lenguaje sencillo
capaz de generar codigo de tamafio muy reducido.

Debido alas diferentes arquitecturas existentes y los problemas de incompatibilidad que
se presentan constantemente, fue importante conseguir una herramienta independiente
del tipo de CPU que se utilice. Se desarrolla un cédigo “neutro” que no es dependiente,
se g ecuta sobre una “maquina virtual” denominada Java Virtual Machine (JVM), que
es quien interpreta el codigo neutro convirtiéndolo a codigo particular de la CPU
utilizada. Con esto se logré lo que luego se ha convertido en el principal lema del
lenguaje: “Write Once, Run Everywhere’. A pesar del gran esfuerzo que representd su
desarrollo ninguna empresa de electrodomésticos se interesd por €l nuevo lenguaje.

Java se introdujo como lenguaje de programacion para computadores a finales de 1995
cuando se incorporé un intérprete Java en el programa Netscape Navigator 2.0,
produciendo una verdadera revolucién en Internet. Java 1.1 aparecié a principios de
1997, mejorando sustancialmente la primera version del lenguaje.

Al programar en Java no se parte de cero. Cualquier aplicacion que se desarrolle se
apoya en un gran numero de clases preexistentes. Algunas pueden ser hechas por €l
propio usuario, otras pueden ser comerciales, pero un gran numero de ellas forman parte
del propio lenguaje (el APl o Application Programming Interface). Java incorpora
muchas funciones importantes como ejecucion remota, componentes, acceso a bases de
datos, etc.

El principal objetivo de Java es llegar a ser el “nexo universal” que conecte a los
usuarios con la informacion, ya esté situada en € ordenador local, en un servidor Web,
en una base de datos o en cualquier otro lugar.

Java es un lenguaje muy completo, en cierta forma casi todo depende de cas todo; por
ello debe aprenderse de modo iterativo primero de modo muy general y refinando en
sucesivas iteraciones.
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un Microsystems describe el lengugje Java como “simple, orientado a objetos,
distribuido, interpretado, robusto, seguro, de arquitectura neutra, portable, de altas
prestaciones, multitarea y dinamico”.

Los programas desarrollados en Java muestran diversas ventgjas frente a los
desarrollados en otros lengugjes. La gecucion de los programas en Java tiene muchas
posibilidades: €jecucién como aplicacion independiente, €ecucion como applet,
gjecucion como serviet, etc. Un applet es una aplicacion especial que se gjecuta dentro
del browser a cargar una pagina HTML desde un servidor Web. El applet se descarga
desde € servidor y no requiere instalacion en e ordenador donde se encuentra €l
browser. Un serviet es una aplicacion sin interface gréfica que se gjecuta en un servidor
de Internet. La gecucion como aplicaciéon independiente es similar a los programas
desarrollados con otros lenguajes. Ademas de la gjecucién como Applet, Java permite
facilmente € desarrollo tanto de arquitecturas cliente-servidor como de aplicaciones
distribuidas, consistentes en crear aplicaciones capaces de conectarse a otros
ordenadores y gjecutar tareas en varios ordenadores simultaneamente, repartiendo por 1o
tanto e trabajo. Aungue también otros lenguajes de programacion permiten crear
aplicaciones de este tipo, Java incorpora en su API estas funcionalidades.

2.2 Distribuciones de la tecnologia Java

Actualmente JavaSoft, empresa del grupo Sun Microsystems que guarda las inversiones
y controla la compatibilidad y el desarrollo de las versiones sucesivas de Java, tiene
disponibles tres distribuciones de esta tecnologia, cada una para un entorno de
gjecucion. Estas distribuciones son paquetes de software que incluyen toda la
plataforma para soportar la gecucion de los programas Java. Los elementos principales
de este conjunto son las APIsy un entorno de g ecucion o maquina virtual.

2.2.1 J2SE-Java2 Standard Edition

- Provee las principales APIsy enfoca el desarrollo de aplicaciones Cliente/Servidor. No
permite la distribucién extendida de objetos ni ofrece soporte a tecnologias para
Internet;

- Provee la Java Runtime Environment (JRE) o laJVM (Java Virtual Machine).

2.2.2 J2EE - Java2 Enterprise Edition

- Provee un conjunto de APIs para desarrollo corporativo y se enfoca a la integracién
entre sistemas. Permite alta distribucion de objetos y ofrece total soporte a tecnologias
para lnternet;

-Depende de I2SE y de JRE.

2.2.3J2ME - Java Micro Edition
- Provee las APIs necesarias para €l desarrollo de aplicaciones para computacion movil,

en peguefios dispositivos o tecnol ogias portatiles,
- Provee un Java Runtime Environment (JRE) de capacidad reducida.
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2.3 Laorganizacion delasAPIsy la plataforma de J2SE.

2.3.1JVM (Java Virtual Machine)

Software gue emulala CPU y memoria parala € ecucién de programas en Java.
2.3.2 JRE (Java Runtime Enviroment)

Entorno obligatorio para la gjecucion de programas en Java. El JRE es compuesto por
JVM y por e conjunto de APIs del J2SE (JVM + APIs = JRE].

2.3.3 SDK (Software Development Kit)

Conjunto de herramientas para compilacion, documentacion y depuracion de errores de
aplicativos Java. El SDK esta compuesto por JRE y por sus herramientas de desarrollo.

2.3.4 HotSpot

Componente del JRE, realiza una compilacion previa de fragmentos del codigo que
agilizala ejecucion de los programas.

Para gecutar cualquier aplicacion java, es necesario tener una JRE, que contiene €l
JVM méslas APIsdel J2SE.

24 TiposdeprogramasJava

El lenguaje Java es muy versatil, pudiendo ser utilizado para construir varios tipos de
aplicaciones, para diferentes medios y finalidades. Las diferencias entre los tipos de
programas que pueden ser desarrollados es el conjunto de APIs utilizado.

2.4.1 Stand-alone: Aplicacion basada en el J2SE que tiene total acceso a los recursos
del sistema, memoria, disco, redes, dispositivos, etc. Es posible gecutar una aplicacion
stand-alone, por ggemplo, en un servidor Web. También es comln ejecutar aplicaciones
stand-alone de automatizacion comercia en estaciones de trabagjo.

2.4.2 Java applets. Pequefias aplicaciones que no tienen acceso a los recursos de
hardware, que necesitan de algun navegador con soporte para J2SE para que sean
gjecutadas. Son generalmente usadas en juegos, animaciones, teclados virtuales, etc.

2.4.3 Java serviets: Programas desarrollados para su gecucion en servidores Web
basados en e J2EE, comunmente usados para generar contenido dindmico para sitios
Web.

2.4.4. Java midlets. Pequeiias aplicaciones, extremadamente seguras y construidas para
ser gecutadas dentro del J2ME. Se usan generalmente en teléfonos moviles,
ordenadores de mano, controladores electrénicos, ordenadores de a bordo, tarjetas
inteligentes, tecnologiaintegrada en vehiculos, etc.’
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2.4.5 JavaBeans. Pequefios programas con patron bastante rigido de codificacion.
Pueden ser reaprovechadas en cualquier tipo de programa en Java, pudiendo ser
Ilamados a partir de aplicaciones stand-alone, applets, servlietsy midlets.

2.5 Caracteristicas fundamentales de la tecnologia Java
L as caracteristicas fundamental es (key features) de la tecnologia Java son:

» Simplicidad: Contiene solamente 48 pal abras reservadas.

* Orientacion a objetos: Permite la programacion orientada a objetos.

* Capacidad de distribucién: Permite la distribucion de aplicaciones en varias JRES (en
estaciones de trabgjo y/o en el servidor) por medio de red.

* Robustez: Utiliza compilacién e interpretaciéon de codigo, o que aumenta su
fiabilidad.

» Portabilidad: «Write once, run anywhere» - una vez escrita y compilada, una
aplicacion en Java se puede ejecutar en cualquier plataforma operativa en que esté
instalada un JRE.

» Multithreading: Permite el desarrollo de aplicaciones para que funcionen en servidores
gue atiendan a muchos usuarios simultaneamente, o de aplicaciones que necesiten
gjecutar méas de unatarea al mismo tiempo.

2.6 Conceptos erréneos sobre Java
A continuacion, los principal es mitos sobre Java:

 Setratade unaextension del HTML.
Falso. En redlidad, € Java es un lenguge completo, derivado del SmallTalk y
del C++.

* Es sdlo un lenguaje como otro cualquiera.
Falso. Java posee un lenguaje Unico, que permite construir componentes para
todos los entornos.

* Todos los programas Java funcionan en paginas Web.
Falso. Existen tres entornos distintos (J2SE, J2EE y J2ME) de gecucion para
programas Java.

* El JavaScript es unaversion light de Java.
Falso. Netscape aprovechd la ola de marketing y bautizd su tecnologia
LiveScript, como JavaScript.

« El lenguaje Java es interpretado, por 10 que es muy lento para aplicaciones serias.
Falso. El lenguaje Java realmente exige interpretacion, pero incluye también
compilacion. Laforma como la pareja compilador/intérprete trata |os programas
garantiza un rendimiento muchas veces equivalente al del C++ (con laventgade
ser un lenguaje mucho més simple que este).
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* Esdificil programar en Java.
Falso. La programacion en Java en si es relativamente simple. La Unica posible
dificultad inicial eslaasimilacion de los conceptos de Orientacion a objetos.

2.7 Laportabilidad de Java

Java usa las dos formas computacionales de gecucion del software (compilacion e
interpretacién), y retne las ventgjas de ambas. Los lengugjes que utilizan sblo
compilacion necesitan de instrucciones adicionales de la plataforma operativa, 10 que
compromete la portabilidad. Por otro lado, los lenguajes que se apoyan sélo sobre la
interpretacion generalmente son muy lentos. La coordinacion de los procesos de
compilacion e interpretacion permite la agilizacion del proceso de desarrollo del
software al mismo tiempo que garantiza la portabilidad de |as aplicaciones creadas.

Combinacion de las formas de g ecucion en Java: en un primer momento, el codigo
se compila, 0 sea, se transforma en instrucciones comprensibles por la Java Virtual
Machine (bytecode).

Ese bytecode, a su vez, puede ser interpretado en varias plataformas operativas, basta
con que tenga un intérprete de Java (incluido en un JRE) instalado. Los fabricantes de
hardware y sistemas operativos, en conjunto con JavaSoft, desarrollaron JRES para
varios entornos operativos. Por eso, las aplicaciones totalmente desarrolladas en Java
son 100% portables.

2.8 La aplicacion Java stand-alone

Para que una aplicacion Java pueda ser considerada del tipo stand-alone y ejecutada
directa mente por €l intérprete, debe poseer el método main, cuya sintaxis es:

public static void main(String argg[])

A partir de esa linea de codigo €l programa Java comienza a gjecutarse. Por |o tanto, €l
método main desempefia la funcion de punto de acceso de una aplicacion stand-alone.
Cuando € proceso de gjecucion llega al fin de ese método, la aplicacion termina.

Lenguaje de programacion Java

Vamos a presentar las principales caracteristicas especificas del lengugje Java: palabras
reservadasy tipos de variables.

2.9 Listadelaspalabrasreservadasdel lenguaje Java

abstract double int static
boolean else interface super
break extends long switch

byte final native syncronized
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case finally new this
catch float null throw
char for package throws
class goto* private transient
const* if protected try
continue implements public void
default import return volatile
do instanceof shot while

“*" Palabras reservadas, pero no usadas por no representar instrucciones de JRE.
2.10 Variables

En lenguges de programacion orientada a objetos, para crear un elemento que
represente datos como un atributo de un objeto o un parametro de un método, debemos
hacer uso de variables. Sirven para almacenar determinado tipo de valor dentro de un
algoritmo. Ese valor puede variar — por eso el nombre «variable».

Se pueden usar variables de tipo primitivo como atributos de objeto, pardametros de
método o variables locales de método.

En el lenguaje Java, existen dostipos de variables:

* Tipos primitivos. capaces de almacenar valores simples, como nimeros enteros y de
toma flotante, caracteresy booleanos. Se usan para gjecutar calculosy comparaciones;

* Tipos de referencia: capaces de almacenar referencias de objetos. Se acepta también
una definicion por exclusion para los tipos de referencia: serian de referencia todos
aguellos que no son primitivos. Se usan para navegar entre |os objetos de un sistema.

2.11 Entorno de Desarrollo de Java

Existen distintos programas comerciales que permiten desarrollar codigo Java. Sun
distribuye gratuitamente e Java Development Kit (JDK), que es un conjunto de
programas y librerias que permiten desarrollar, compilar y gecutar programas en Java.
Incorpora ademas la posibilidad de gecutar parcialmente e programa, deteniendo la
gjecucion en el punto deseado y estudiando en cada momento el valor de cada una delas
variables (Depurador o Debugger). Por experiencia sabemos que usua mente la mayor
parte del tiempo de desarrollo se destina a la deteccidn y correccion de errores. Existe
también una version reducida del JDK, denominada JRE (Java Runtime Environment)
gue solo gjecuta codigo Java, no permite compilar.

Existen también los IDEs (Integrated Development Environment) o entornos de
desarrollo integrados, que en el mismo programa se puede escribir el codigo, compilarlo
y e ecutarlo sin tener que cambiar de aplicacion.
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Algunos incluyen una herramienta para depurar graficamente mucho mas sencilla frente
aladel JDK gue utiliza una consola de MS-DOS. Estos entornos integrados permiten
desarrollar aplicaciones mucho mas rgpido, incorporando en muchos casos librerias con
componentes ya desarrollados que se incorporan al proyecto. Como inconvenientes se
pueden sefidlar algunos fallos de compatibilidad entre plataformas y ficheros resultantes
de mayor tamafio que los basados en clases estéandar.

2.12 El compilador de Java

Es una de |as herramientas de desarrollo incluidas en el JDK. Este analiza la sintaxis del
codigo escrito en los ficheros fuente de Java (*.java). Si no hay errores genera los
ficheros compilados (*.class). Sino muestralalinea o lineas erroness.

2.13 LaJava Virtual Machine

La existencia de distintos tipos de procesadores y ordenadores llevé a los ingenieros de
Sun ala conclusion de que era muy importante conseguir un software que no dependiera
del tipo de procesador utilizado. Se plantea la necesidad de conseguir un cédigo capaz
de gecutarse en cualquier tipo de maguina. Una vez compilado no deberia ser necesaria
ninguna modificacion por e hecho de cambiar de procesador o de egjecutarlo en otra
maquina. La clave consistié en desarrollar un codigo “neutro” e cua estuviera
preparado para ser gjecutado sobre una “méaquina virtual”, denominada Java Virtual
Machine (JVM). Es esta JVM quien interpreta este codigo neutro convirtiéndolo a
codigo particular de la CPU o chip utilizada. Asi se evitatener que realizar un programa
diferente para cada CPU o plataforma. Esta JVM es € intérprete de Java. Ejecuta los
“bytecodes’ (ficheros compilados * .class) creados por el compilador de Java.

2.14 Instalacion del Entorno Java

L os pasos que detallamos a continuacion son 10s pasos a seguir para instalar el J2SE de
Java en Windows XP:

1. Instalamos € J2SE 6 de Java (jdk1.6.0) que es la version que funciona
correctamente con la version de Eclipse que utilizamos.

2. Sedebe cambiar la variable de entorno PATH que se encuentra en:
Inicio - Panel de Control - Sistema - Opciones Avanzadas
Aqui damos click en Variables de Entorno.

En la parte de Variables del Sistema seleccionamos la variable PATH y damos
un click en Modificar, y agregamos a inicio de esta:

C:\Program Files\Java\jdk1.6.0\bin;
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3. En caso de que se vaya a llamar a paquetes contenidos en otras carpetas
modificamos la variable CLASSPATH de igual formaingresamos &

Inicio - Panel de Control > Sistema - Opciones Avanzadas
Damos click en Variables de Entorno.

Aqui en lugar de Variables del Sistema, buscamos en la parte de variables de
usuario, si ya existe CLASSPATH la Modificamos sino seleccionamos Nueva,
se agrega a fina de esta la carpeta desde donde van a ser accedidos los
paquetes:

4. Los plugins necesarios se instalan automaticamente al instalar el J2SE.
2.15 CONCLUSION

Java tiene como metallegar a ser €l “nexo universal”, conectando alos usuarios con la
informacion, ya esté situada en el ordenador local, en un servidor Web, en una base de
datos 0 en cualquier otro lugar.

Este es un lenguaje muy completo, en cierta forma casi todo depende de casi todo, ala
vez es. simple, orientado a objetos, distribuido, interpretado, robusto, seguro, de
arquitectura neutra, portable, de altas prestaciones, multitareay dindmico”.
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CAPITULO 3

3.1INTRODUCCION

Eclipse fue desarrollado originamente por IBM como € sucesor de su familia de
herramientas para VisualAge. Eclipse es ahora desarrollado por la Fundacién Eclipse,
una organizacion independiente sin dnimo de lucro que fomenta una comunidad de
codigo abierto y un conjunto de productos complementarios, capacidadesy servicios.

Desarrollador: Eclipse Foundation

Ultima version: 3.2.1/ 21 de Septiembre de 2006
S.O. Multiplataforma

Género: Java SDK

Licencia: Eclipse Public License

3.1.1 Caracteristicas
Laversion actual de Eclipse dispone de las siguientes caracteristicas:

Editor de texto

Resdtado de sintaxis

Compilacién en tiempo real

Pruebas unitarias con JUnit

Control de versiones con CVS

Integracion con Ant

Asistentes (wizards): para creacion de proyectos, clases, tests, etc.
Refactorizacion
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3.2 Historia

Eclipse comenz6 como un proyecto de IBM Canada. Fue desarrollado por OTI (Object
Technology International) como reemplazo de VisualAge también desarrollado por
OTI. En Noviembre del 2001, se formo un consorcio para € desarrollo futuro de
Eclipse como codigo abierto. En 2003, la fundacion independiente de IBM fue creada.

Eclipse 3.0 (2003) selecciond las especificaciones de la plataforma OSGi como la
arquitectura de tiempo de gjecucion.

En 2006 la fundacion Eclipse coordino sus 10 proyectos de cédigo abierto, incluyendo
la Plataforma 3.2, para que sean liberados el mismo dia. Esta liberacion simulténea fue
conocida como laliberacion Callisto.

3.2.1Licencias

Eclipse fue liberado originalmente bagjo la Common Public License, pero después fue
re-licenciado bajo la Eclipse Public License. La Free Software Foundation ha dicho que
ambas licencias son licencias de software libre.

3.2.2 ldiomas

Alemén, Arabe, Checo, Chino Simplificado, Chino Tradicional, Coreano, Espafiol,
Francés, Hungaro, Inglés, Italiano, Japonés, Polaco, Portugués (Brazil) y Ruso
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3.3DESCARGA E INSTALACION

Para poder empezar a trabagjar con la herramienta “Eclipse”, esta puede ser descargada
de su sitio Web www.eclipse.org, esta es la pagina principal, después de esto debes
ingresar alazona de descargas dando un click en € siguiente boton.

| Download Eclipse

Figural: Botén hacia la zona de descarga

Yaunavez dentro de la zona de descargas se puede ver un link para descargar la tltima
version de “Eclipse’, que es la que nosotros elegimos.

’_i Download now: Eclipse SDK 3.2.1. Windows (120 MB) [torrents]
;\ Problems extracting the ZIP file? Please read these Known Issues.
! “'.'"

(N
gL

&

Other downloads for 3.2.1. | All versions | Release Notes | Documentation
Figura2: Link de descarga de Eclipse 3.2.1

Al dar click aqui se envia a otra pagina donde se muestra todos los links de donde se
puede descargar este software, se indica €l lugar més cercano a la ubicacién que tienes
paralograr que la descarga se realice mas rapidamente.

Después de dar click en uno de estos sitios se puede proceder con la descarga.

File Download

Do you want to open or save this file?
B Name: edipse-5DK-3. 2. 1-win32.zip
| i

Type: Compressed (zipped) Folder; 120 MB

From: download.edipse.org

[ Open I [ Save ] [ Cancel_]

Awayz ask before opening this type of file

While files from the Intemet can be useful, some files can potentially
harm your computer. f you do not trust the source, do not open or
save this file. What's the risk ?

Figura: Cuadro de descarga de Eclipse

Una vez descargado el archivo eclipse-SDK-3.2.1-win32.zip 1o Unico que queda para
poder utilizarlo es descomprimirlo en la carpeta de Archivos de Programayy listo, dentro
de esta se encuentra el archivo eclipse.exe con el que se puede correr el programa.

edipse

G

Figura: Ejecutable de la Aplicacion Eclipse

Al gecutar €l programa lo primero que nos pide es establecer €l espacio de trabgo o
“Workspace” del proyecto, se puede abrir uno ya existente 0 Sino crear un proyecto
nuevo para empezar atrabajar en este.
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& Workspace Launcher

Select a workspace

Edlipse SDK stores your projects in a folder called a workspace.,
Choose a workspace folder to use for this session.

Workspace: |C:'l.WORKSPACESH,Ejemplolmportar v! Browse...

[[Use this as the default and do not ask again

[ OK ] [ Cancel

Figura3: Eleccion del Espacio de Trabajo (Workspace) del Proyecto

34ENTORNO DE PROYECTOSDE ECLIPSE

Todo archivo se amacena dentro de un proyecto. Es decir que todo documento, carpeta,
archivo de codigo fuente (.java) y codigo compilado (.class) tiene que estar contenido
dentro de un proyecto.

Hay que tener completamente en claro la estructura de proyectos de Eclipse antes de
usarlo para programar en Java, es preciso establecer un nuevo proyecto no solo para
desarrollar un nuevo programa de Java, sino para editar también archivos ya existentes.
3.4.1 Crear un Nuevo Proyecto

En lalinea de menu principal tenemos que seleccionar:

"File > New > Project...". Es posible también seleccionar "New > Project..." dando un
click derecho en cualquier parte de Eclipse (Package Explorer, Resource Navigator).

& Java - Eclipse SDK

Edit Source Refactor

Mavigate Search Project Run  Fieldassist
Alt+Shift+n  #

Window Help

% Project... P

Dpen File...

: B Package
(& Class

Figurad: Menu Principal
3.4.2 Tipos de proyectos de Eclipse que pueden crear se:

e Siempre un "Java Project” deberia ser creado cuando se quiere crear o editar
programas Java. En un proyecto de Java también puede recopilarse toda la
informacion relacionada con e proyecto (no tiene que ser solo cédigo fuente,
también puede llevarse documentacién y otros archivos que tenga unarelacion).

e Siempre gue se creen archivos ".java' seria recomendable crear un "Java
Project". Los"Simple Project” solo deberian crearse para almacenar documentos
y otros archivos, pero no codigo Java que se desee compilar.
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e Los "Plug-in Development Project” se utilizan para sumar nuevos moédulos y
funciones a entorno Eclipse.
e Losproyectosde"EMF" se utilizan para crear modelos de andlisisy disefio.

Para crear un nuevo proyecto:

"Java Project" seleccionando "Java > Java Project” y haciendo click en el botén "Next
>" del asistente de creacion.

= New Project a

Select a wizard p—

Create a Java project

Wizards:

Ltfpe filter text

_@ =4=4 Project
& Java Project fram Existing &nt Buildfile
42 Plug-in Project

-2 General

H-= CVS

- Eclipse Modeling Frarmework

w- (= Java

- [= Plug-in Development

#-= Team Logical Model Exarmple

+- [ Exarmples

T s A o

r+_|

53]

[

@ < Back Mext = Finish Cancel

Figura5: Creacién de un Proyecto de Java.
Se debe dar un nuevo nombre para nuestro proyecto lo llamaremos “Manua”.

S se usa € directorio por defecto, los archivos del proyecto se almacenaran en €
directorio "C:MANUAL \manual". Es posible también especificar un directorio
diferente en el que guardar dichos contenidos.
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& New Java Project m

Create a Java project .
Create a Java project in the workspace or in an external location. /

Project name: } MANLUIAL |

Contents

O Create project from existing source

| e i B | Browse...

Figura6: Creacién de un proyecto en espacio de trabajo

Aqui se puede terminar la creacidon del nuevo proyecto haciendo click en e boton
"Finish", pero se recomienda pulsar € botén "Next >" parapoder concretar una carpeta
fuente paralos archivos ".java" desde el principio.

Estas carpetas fuente ("Source Folders') acumulan los archivos de cédigo fuente de
Java (java), de manera que Eclipse sepa donde encontrarlos y pueda redizar la
compilacion automatica de los mismos cada vez que un archivo sea guardado.

] & Folder Selection
Java Settings

Define the lava build settings. Choose the folder for the build output:

= el sl

= Source ﬁ:‘; Projects. = Libra

- D
“EJ h:‘ﬁ‘ manual
R (default package)

Create Mew Folder...
» Details
[l Allows output falders for source fi @ [ oK ] [ e ]
Default output folder:
| maral | ’ Browse... J ‘ I

Figura7: Eleccion de una carpeta para el proyecto
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Cuando vayamos a crear la carpeta fuente seleccionamos la pestafia de "Source" y
pulsamos & botén "Browse/folder selection.”. Seleccione el proyecto recientemente
creado y pulse el boton "Create New Folder". Asi, losarchivos".class' que resulten de
la compilacion de los ".java' almacenados en la carpeta fuente irdn a parar a la carpeta
"\bin". Pulsamos € botén "Finish" para terminar € proceso de creacion del nuevo
proyecto.

La Opcion "Create separate source and output folders" sirve para construir de forma
automatica la estructura de archivos deseada.

Project layout

(CUse project folder as root for sources and class files

(¥ Create separate source and output folders Configure default...

Figura8: Construir de forma automética la estructura de archivos deseada.

Si queremos editar un elemento existente deberia ser primero importado dentro de un
proyecto de Eclipse. Podemos hacerlo desde e menu "File > Import..." o bien dando un
click con el boton derecho en cualquier punto de la vista del "Package Explorer” o del
"Resource Navigator'. Si queremos seleccionar un archivo o directorio hay que
seleccionar "File system™ en e sub mend de importacion. Entonces sélo habra que
recorrer los directorios marcando los archivos que se deseen importar asi como €
proyecto y la carpeta destino.

Select

Impart resources from the local file system into an existing pro

Select an import source:

. type filter text
= General
[E, archive File
o2 Breakpoints
12 Existing Projects into Workspace

L Preferences
= CWS
-2 Plug-in Development
L= Team

Figura 9: Seleccion de una fuente de importacion.
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Todo elemento que se importa en Eclipse se duplica.

Es decir que borrar la copia que Eclipse esté manejando no borrard € archivo original,
de manera que se seguira teniendo una copia de reserva. Pero, si se usa la opcion de
importar un proyecto de Eclipse ya existente, los contenidos de dicho proyecto seran
duplicados. Por esto hay que ser muy cuidadosos a borrar proyectos importados del
entorno de trabajo de Eclipse, ya que es posible que otras copias de backup de dicho
proyecto no existan.

Cualquier archivo creado mediante la utilizacion de Eclipse puede exportarse como un

archivo normal (seleccionando Export... > File System), como ".jar" hasta archivos
comprimidos en ".zip". El proceso que hay que seguir es similar de importacion.

File system =
Please enter a destination directory. f
® ¥ e el 5 .classpath
5l .project
Select Types... ] [ Select all ] [ Deselect All

FiguralO: Seleccién de un directorio destino.
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3.5CREAR ELEMENTOSDE JAVA

Luego de crear un nuevo proyecto, se procede a la creaciéon de elementos de java. Para
continuar con los siguientes pasos es necesario cambiar a la "Perspectiva Java.
Seleccionamos "Window >Open Perspectives > Java'.Contiene las vistas y editores
mas Utiles ala hora de crear nuevos programas en Java.

Dando un click derecho en la carpeta fuente recientemente creada (por gemplo, "src")
dentro de la vista del Package Explorer, aparecera un menu contextual. Seleccionando
"New >" se mostrard una lista con los diversos elementos de Java que pueden ser
creados.

[ Project...

H¥ Package
(& Class
& Interface
& Enum
(@ Annotation
&% Source Folder
% Folder

I File

= Untitled Text File
ET Jnit Test Case
G visual Class

% Example...

4 Other...
Figurall: Menu contextual

Pueden ser creados también dando click sobre los iconos del menu de la parte superior
dela pantalla.

EH G- @3
s Menw Jawa Classi

Figural2: Bot6n para crear una nueva clase
3.5.1 Java Class

Son los archivos ".java' (cédigo fuente) y que luego son compilados en archivos
".class'. Estos archivos Java tienen gque ser almacenados dentro de la carpeta fuente
recientemente creada (por gemplo, "src"). Si pulsamos "New > Class' abrimos la
ventana de creacion de clases.
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£ New Java Class X

Java Class =
‘ 1, The use of the default package is discouraged. 'I“\#
Source folder: manualdsrc
Package: ._ (default)
[ClErclosing type: ;
Marne: Clisnteg|
Madifiers: & public O default i ]

Cabstract [final st
Superclass: ._ja\ra.lang.Object ._
Interfaces: add. ..

Which rmethod stubs would you like to create?
[ public static vaid main(String[] args)
[ Constructors fram superclass
[lIrherited abstract methads
Do you want o add comments as configured in the properties of the current project?
[Gererate comments

@ [_Fin ish ] [ Cancel

Figural3: Nueva clase de Java

Si no se especifica ninglin paquete para contener las clases Java, se guardaran dentro de
un paquete por defecto. EI nombre que se le da a la clase es e Ultimo campo
obligatorio. El nombre de una clase debe comenzar con mayuscula. Nosotros crearemos
laclase clientes.

También existen otros elementos que pueden ser facilmente afadidos a una clase desde
el mismo momento de su creacién. Estos también podrian ser incrementados
manual mente en otras etapas méas avanzadas del proceso de desarrollo.

Cuando se quiere que la nueva clase herede de otra clase existente, se deberia describir
la clase "padre" dentro del campo "Superclass'.

El botdn "Browse..." es de gran utilidad a la hora de encontrar clases que sean posibles
candidatas para ser extendidas. A pesar de gue Java solo soporta herencia Unica (puede
heredarse solo de una Unica clase) es posible que una clase implemente més de una
interfaz. "Browse..." simplificalatarea de seleccionar interfaces implementadas.

Si gueremos que la nueva clase contenga un método "main” (punto inicial de gecucién
del programa), puede sumarse dicho método autométicamente marcando la casilla con
la opcion apropiada. También pueden implementarse de esta manera |os constructores
de la superclase y todos los métodos abstractos heredados. Esta Ultima opcidn es muy
préctica s se desea instanciar la clase, puesto que para esto todo método abstracto
deberia estar implementado.
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Los archivos compilados ".class' solo son visibles en la ventana "Navigator”, abierta
por defecto dentro de la perspectiva "Resource”. Debido a que la perspectiva de Java no
abre esa ventana por defecto, los ficheros .class no serén visibles en la vista del Package
Explorer. Sin embargo, basta con escribir y guardar un archivo ".java" para que se cree
un archivo ".class' resultante de compilar €l archivo fuente anterior.

i Package Explorer X Hierarchy.Navige Package Explarer  Hierarchy m

= & marual = =2 manual
SR | w2 bin
= (default package’ =] ff:‘/ﬁ
&-[J] Clientes. java [J] Clientes.java
Bk JRE System Library [jrel.5.0_09] El .classpath
2 .project

Figura 14: Package Explorer, navigator

3.5.2File

Cuando se crean los archivos a través de este mend suelen amacenar notas e
informacion general. Para crear un nuevo archivo pulsamos "New > File", seleccionar €l
proyecto y carpeta adecuados en que se desea crear el archivo, dar nombre a nuevo
archivo y pulsar € boton "Finish". Por defecto, los archivos genéricos se abren en €l
editor de texto.

ENGER ST @ Hierarchy | Mavi [J] Clientes. java E *notas =2

= =2 manual Loz cddigos son numéricos
= src
=8 (default packags)
: #- 4] Clientes. java
B JRE System Library [jrel.5.0_09
=Rnotas

Figura 15: Crear un archivo.

3.5.3 Folder

L as carpetas se utilizan para almacenar y organizar archivos. Una carpeta normal no es
exactamente lo mismo que una carpeta fuente. Si ponemos un gjemplo, en una carpeta
fuente se amacenan los archivos .java con el codigo fuente (src), en una carpeta de
salida codigo compilado (bin) y en otra carpeta se guarda toda la documentacion
relacionada (docs). Para crear una nueva carpeta basta con especificar el nombre de la
nueva carpetay la carpeta que la contiene.
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& New Folder X
Folder —
R
Create a new folder resource, lf /
Enter or select the parent falder:
! manual | )
o i Package Explorer | Hierarchy m
= = manual = =2 manual
= bin -2 bin
= (== {ulule}
- src
2 .classpath
B project
= notas

Folder name: | docs]

Figura: navigator

@ Finish ] ’ Cancel

Figural6: Crear una nueva carpeta

3.5.4 Interface

Decimos que las interfaces son casos especificos de las clases de Java, que carecen de
implementacion y que se espera que otras clases implementen. Indicando lo que la clase
implementada deberia hacer, mientras que los detales de mas bago nivel
corresponderian a implementador.

El procedimiento de estas es similar a de la creacion de nuevas clases. Unainterfaz no

puede implementar ninguna interfaz, pero s puede extender otra interfaz mediante una
relacion de herencia.
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3.5.5 Package

Los paquetes se declaran para almacenar y organizar los archivos de Java. El nombre
de un pagquete consta usualmente de varias partes separadas por puntos. Cada una de
estas partes sera un directorio nuevo dentro del sistema de archivos. Las clases que se
creen dentro de un paquete determinado en Eclipse llevaran afiadida autométicamente la
declaracién "package” en su codigo fuente.

3.5.6 Scrapbook Page

"Hojas de sucio” Forma sencilla de probar fragmentos de codigo antes de afadirlos a
programa final. Solo hay que crear una " Scrapbook Page" dentro de la carpeta deseaday
escribir €l codigo dentro de ella. No hace falta meter el codigo dentro de un método
main para g ecutarlo.

Estas "scrapbook pages' no se muestran directamente en el menu contextual. Para crear
una nueva hoja de sucio seleccionamos "New > Other > Java > Java Run/Debug >
Scrapbook Page'.

<7 Undo Typing Cirkz

Revert File
Save

Show In Alt+shiftHd »
Cut iy
Copy CirH+C
Paste Chry

Show i Package Explorer

i, Inspect Cir HShift+l
Display Cir+shift+D
@ Execute Cirku

Run As

Debug As

Team

Cornpare With

Replace with

=i

- v v v v

= Set Imports...

Preferences...

Figural6: Menu Contextual

Es necesario importar las clases usadas antes de intentar gjecutar €l cddigo afiadido.
Para ello basta con realizar click derecho sobre cualquier parte de la hoja 'y seleccionar
"Set Imports' del menu contextual. Ahi es donde hay que especificar los tipos y
paguetes que es necesario afiadir.

Si queremos gjecutar el cddigo recién creado es necesario seleccionarlo dando click con
el boton izquierdo del ratén y arrastrando hasta tener todo el cédigo seleccionado.
Luego pulsamos € boton derecho del raton sobre este codigo seleccionado y
gjecutamos la opcion "Execute' del menld contextual. La salida estandar de dicho
proceso se mostrara dentro de la vista "Consol€e", y otros mensajes de error se mostraran
dentro de la misma hoja de sucio.

Una vez que se ha completado |a prueba pulsamos €l botdn "Stop Evaluation” del menu
contextual.
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3.5.7 Source Folder

Estas carpetas fuente son un tipo especia de carpetas destinadas a almacenar los
archivos fuentes de Java (".java'). Estos archivos de codigo serdn automaticamente
compilados en archivos ".class'. Todo proyecto de Java deberia tener una carpeta
fuente.

3.6 FUNCIONESUTILESDE PROGRAMACION

A continuacion presentaremos las funciones de ayuda a la programacion de Java en
Eclipse. Nos daremos cuenta de como usar Eclipse para programar en Java esto ahorra
gran cantidad de tiempo y esfuerzo.

3.6.1 Compilar y Detectar Errores

Los errores de compilacion se muestran en Eclipse en tiempo rea subrayando el
fragmento de codigo adecuado con una linea roja. Y ademés el entorno
automati camente compila los archivos salvados. Entonces no es necesario pasar por €l
lento proceso de compilar - observar 10s errores - corregir 10s errores.

Todos los errores pueden encontrarse facilmente porgue se muestran ademas como
marcas rojas en € margen derecho del editor de codigo Java. También los errores y
advertencias presentes en archivos ya guardados se muestran dentro de la vista de tareas
(Tasks View), como se detallara posteriormente.

Dando un click en cualquiera de los dos tipos de marcadores de error llevara
automaticamente hasta la linea en que € error estd presente. Las advertencias
(warnings) se muestran de la misma manera, pero con marcas amarillas.

El notas [1) hojas. jpage = O 5= Outline &2 =0
O AR e W~
= {2, Clientes
@ 9 main(String[ )

public class Clientes |
public static void maini3tring[]largs){

Integer i= new intege(l):
i

‘.’&:
4

i
]

[%¢ Problems &2 . Declaration | Call Hierarchy

1 error, O warnings, 0 infos

Description Resource Path Location
= E: Errors (1 item)
@ intege cannot be resolved to a type Clientes.java  manualfsrc line 5

Figural7: Compilar y Detectar Errores
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3.6.2 Icono de Bombilla = Auto corregir

Eclipse detecta y marca todo error y advertencia de compilacion. Permite auto corregir
los posibles errores haciendo click en el icono de bombilla presente en el margen
izquierdo del editor de codigo. Aparecera una ventana mostrando todas las opciones.
Seleccionamos  una opcion mediante los cursores del teclado o degjamos la punta del
raton sobre dicha opcion esto abrira una nueva ventana mostrando detalladamente las
modificaciones de codigo que la auto correccion efectuaria. Basta con pulsar la opcion
seleccionada (o0 pulsar ENTER) para hacer que Eclipse lleve a cabo la correccion
automati zada.

public class Clientes {
public static void maini(3tring[]args) {

La Integer i= new [lagas
@ Change to 'Integer' (java.lang)
Integer i= new Integer(1y; 3 Create class 'intege’
- @ Change to 'IFGE' {com.sun.org.apache.beel.internal,
I a Change to Tmage' (java.awt)

@ Change to 'Integerarray’ {com.sun.org.apache. xalar
@ Change to 'TntegerDy!' (com.sun.org. apache xerces.i
@ Change o 'INTERNAL' (org.omg . CORBA)
@ Change to 'IntTrie’ {sun.text)
@ Change to 'IntType' (com.sun.org.apache.xalan. inter
| # Rename in file (Ctr+2, R direct access)
| < ¥

Figural8: Auto corregir
3.6.3 CTRL + Espacio = Auto completar
Esta funcién de ayuda a la programacion es muy Util.
e Nombresde Clases

Cuando se crea referencias a otras clases dentro de la clase actual es visto esto como
una tarea de programacién habitual. Pero algunas clases de Java tienen nombres muy
largos que son dificiles de recordar. Ademas, es necesario afadir declaraciones de
importacion para poder resolver dichas referencias a clases alahora de compilar.

"CTRL + Espacio” tras escribir los primeros caracteres del nombre de una clase Java
mostrara las posibles aternativas. Puede seleccionar cualquiera de ellas simplemente
realizando click izquierdo del raton. La sentencia de importacion correspondiente se
anadira de forma automética. Las clases se marcan con una "C" verde mientras que las
interfaces se marcan con una 1" morada. El paquete a que pertenece la clase se muestra
también, permitiendo de este modo evitar posibles confusiones.
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public static void main(String[] args){
roid mainiString[] args) {| = main - main method
O maintoid  void

Press 'Ctrl+Space’ to show Template Proposals

Figural9: ctrl.+space
e Atributosy Variables Locales

S definimos una clase es norma dar nombres inventados a sus atributos y a las
variables internas de los métodos. Pero en ocasiones resulta dificil recordar e nombre
exacto. Tras escribir los primeros caracteres del atributo o de la variable local, pulsar
"CTRL + Espacio" mostrara las posibles aternativas. Este proceso es muy similar al de
auto completar el nombre de las clases recientemente expuesto. Las variables locales se
marcan con €l icono de una"L" gris, mientras que los atributos se marcan con un icono
que puede variar segun lavisibilidad del atributo.

i
oo Integer A
=l if - if statement
= ifelse - if else statement
@ jiopnameURLContExFactory - corm.sur, jadi.url.iic
@ jiopURLContext - carm.sun., jrdiurl.iiop
@ jiopURLContextFactary - car,sun, jrdiurl,iiop
@ internal_error - com.sun, java_cup.internal

if

int
@ IllegalaccessErrar - java.lang “
< >

Press 'Ctrl+Space’ to show Termplate Proposals

Figura20: Marcas en variablesy atributos
e Métodosy Constructores

Cuando se haya creado un objeto Java pueden Ilamarse los métodos correspondientes a
su clase. Sin embargo, es bastante habitual olvidar el nombre de un método en concreto,
0 incluso los tipos de sus parametros y su orden. Este problema puede solucionarse
facilmente pulsando "CTRL + Espacio” tras escribir el nombre del objeto seguido de un
punto, lo cua mostrara una ventana con las posibles alternativas. Pulsar sobre la
alternativa escogida afadira la signatura del método al objeto.
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public static wvoid main(Scring[largs) {

Integer cli= new Integer(1):
byte b= gli.

i @ bytevalue) byte - Integer b
et @ compareTo(Integer argd) int - Integer

¥ @ doublevalue) double - Integer
} @ equals(Object argdy boolean - Integer

@ floatvalue) float - Integer

@ getClass() Class<? ewtends Ohjects - Object

@ hashCode() int - Integer

@ intvalue() int - Integer

@ longvalued long - Integer

@ notify () woid - Object

@ notifyall) void - Object v
Press 'Ctrl+Space’ to show Template Proposals

Figura2l: Métodosy Constructores

Se puede también auto completar la marca de los constructores pulsando "CTRL +
Espacio” tras escribir (0 auto completar) el nombre de la clase seguido de un signo de
apertura de paréntesis, " (".

Integer cli= new Integerl
byte b= cli. @ Integer(int argd} - Integer
3 @ Integer (String argd’ - Integer

i

P,

¥

Figura 22: Auto completar

Cuando escribamos las primeras letras del modificador de un método tal como "public"
o "private”, "CTRL + Espacio” le permitird crear automaticamente una plantilla del
método. Pulsar el tabulador permite saltar de un campo de la plantilla a otro, de manera
gue se pueda completar €l tipo de retorno, el nombre del método y sus parametros.

i [E public_method - public method
i

Figura 23: Auto completar
e Bucles

Estos estén presentes en todos los programas. A pesar de que crear un bucle no es una
tarea compleja, Eclipse proporciona algunas funciones de auto completado que pueden
acelerar considerablemente el proceso. Basta con escribir "do"”, "Chile" o "Foz" y pulsar
"CTRL + Espacio" para mostrar las posibles opciones. Si el bucle ha sido creado con €l
propésito de recalcar sobre un arria de el ementos, seleccionar esta opcion intentard auto
completar incluso el nombre del array.
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while (condition) §

while [(enumeration.hasMoreElementsi()) { | = while - iterate with enumeration
type element = (type] enumerd = whilz - iterate with iterator
= while - while loop with condition
i while

Figura 24: Bucles

o Etiquetas de Javadoc

Los comentarios internos del programador se indican con una "//", los comentarios de
Javadoc se inician con un "/**". Tras crear un método, afiadir "/** + ENTER" sobre la
signatura del método auto completara informacion de. Pulsar "CTRL + Espacio” dentro
deun bloque"/** ... */" mostraratodalalista de etiquetas Javadoc posibles.

m

¢y <h>
e 4> <blockquotes
< »<hr>
e &> <C0R=
o &> 0>
<> <dl=
< <dt=
<> <ams>
150 ¢ <hl>
¢y <h2>

an el

Figura 25: Etiquetas de Javadoc

3.6. 4 Menl " Source"

Si damos un click derecho en el editor de codigo se mostrard un mend contextual. Las
funciones mas importantes de su submenu " Source >" son las siguientes:

e Toggle Comment

Con esto podemos cambiar €l estado del cédigo seleccionado, pasandolo de comentario
acodigo o viceversa.

e Add Block Comment

Esto se encargara de marcar €l cédigo como comentario rodedndolo con los simbolos
"y "*[". Mientras que seleccionar un bloque de cddigo comprendido entre esos
simbolos de comentario haré que en aparezca la opcion "Remove Block Comment”, la
cual eliminarialos simbolos de comentario.
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e Format

Esta funcién de formateado automatico de cddigo autométicamente posiciona el codigo
de laforma adecuada, ademés de llevar a cabo otras funciones de representacién. Es una
forma rdpida de conseguir tener un cédigo ordenado y comprensible.

Permitiendo especificar opciones avanzadas de formateo de codigo. La pégina de
preferencias que permite configurar €l formateo de cédigo se ha trasladado a "Window
> Preferences > Java > Code Style > Code Formatter". Pese a que las opciones se
pueden configurar de acuerdo a las preferencias personales, ya vienen configuradas por
defecto para cumplir las convenciones de Java.

e Organise and Add Imports

A pesar de que las sentencias de importacion adecuadas se muestran siempre cuando se
usan las funciones de auto completar codigo para completar el nombre de una clase
Java, nuevas sentencias de importacion pueden afiadirse en cualquier momento usando
lafuncion "Add Import”. Si pulsamos "Organise Imports" eliminamos automaticamente
todas las declaraciones de importacion no utilizadas, incrementando la eficiencia del
codigo. El método abreviado del teclado es"CTRL + Mayusculas + O".

import java.net.ServerSocket;

e
ERan Ut import jawva.net.Socket;

Add Import
Figura: Organizar y Afiadir | mportes
e Override and Implement Methods
Seleccionando esta opcion de sombrear o implementar métodos abrird una ventana de

menu en la cual se podrédn marcar los métodos de la superclase cuya signatura se desea
que se afiada.
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Uverridef/implemen

Select methods to override or implement: 4)&;
O« cloned @J
O e equalsChject)
< finalize(y
[ e hashCode)
O e tostringd)

Insertion point:
|cursar position v
[JGenerate method comments

The format of the method stubs may be configured on the Code Templates preference page.

i 10fS selected.

@ OK l ’ Cancel

protected void finalize() throws Throwable {
J4 TODD huto-generated method stub
super.finalize();

Figura 26: Métodos de | mplementacion

La opcion "Add Constructors from Superclass’ permitira especiadizar todos los
constructores usados.

e Generate Getter and Setter

Java permite especificar diferentes niveles de visibilidad de atributos. A pesar de esto,
en programacion orientada a objetos, los atributos internos de una clase deberian ser
siempre privados. Esto quiere decir que no deberia poder realizarse ningun tipo de
modificacion directa del atributo de una clase desde otra clase externa. A causa de esto,
la tnica manera de acceder a un atributo privado para leer su valor o bien para darle un
nuevo valor seria utilizando un método modificador que sea publico. Seleccionando
"Generate Getter and Setter” una ventana mostrando los posibles métodos que podrian
crearse de acuerdo con los atributos definidos aparecerd. Entonces los métodos
necesarios podrian crearse simplemente selecciondndolos y pulsando "Ok™.
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& Generate Getters and Setters

Select getters and setters to create:
. 3-[] & (B

[E] = Direccion
o getDireccion)
[ e sethireccion{String)
m-[] & etiquetas
- & lista
=-[F = rnombre
o gethombral)
[ e sethombre(String)
[1 & posibles
[ = telfono
O & toda

]

LN}

=

B8

public String getDireccion() {
return Direccion;

i

public String getMNombre() {
return nombre;

Figura 27: Niveles de Visibilidad
e  Surround with try/catch block

Para el uso adecuado de esta opcidn es necesario tener seleccionado de antemano un
fragmento de codigo dando un click con el boton izquierdo del raton (o pulsando
Mayusculas) y arrastrando. Activar esta opcion creara un bloque "try" alrededor del
codigo seleccionado. Tras este blogue se afiadiran automati camente los bloques "catch”
adecuados, los cuales atraparan toda posible excepciéon que el cédigo rodeado pueda
lanzar. Por defecto se afiade una sentencia de traza dentro de esos bloques "catch” de
manera que sea posible identificar inmediatamente donde se lanzo la excepcion.

socket = new Socket (“localhost”, 100);

Cuando una excepcion no es atrapada, aparecera como texto en rojo (de la salida de
error estandar) en la vista "Consol€". Pulsar la linea de cddigo se muestra en qué linea
tuvo lugar la excepcion llevard directamente a ese punto del programa en el editor de
codigo.

try {
Socket= new Socket ("localhost™,100) ;

} catch (Exception e) |
A TODD: handle exception
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3.6.5 Refactor Menu

Dando un click derecho en e editor de codigo mostrara € menu contextual. A
continuacion se muestran las funciones mas interesantes del sub menu " Refactor >".

e Rename

Para invocar la funcion de renombrado hay que tener previamente seleccionado un
elemento.

"Update references’ actualizara toda referencia a nuevo elemento renombrado. Usando
esta opcion de "Refactor > Rename..." es como deberian renombrarse todos los
elementos incluyendo los archivos ".java'. Asi se actualizan todas las referencias no
apareceran problemas ala hora de compilar. Al renombrar determinados elementos sera
posible actualizar también referencias en comentario de Javadoc, comentarios normales
y cadenas de caracteres entrecomilladas, lo cual también puede resultar bastante Util. La
opcién de "Preview" permite asegurarse de que no habra ningun tipo de error durante la
operacion de renombrado.

& Rename Type @

Mew name: | Clien]
[¥]Update references
[“lUpdate similarly named varizhles and methads Configure...

[¥]Update textual accurrences in comments and strings (forces preview)

T G

Figura28: Renombrar elementos

¢« Move

Antes de seleccionar "Refactor > Move...", e archivo fuente o elemento que se desea
mover debera haber sido seleccionado. Entonces serd solo necesario seleccionar €l
destino de manera que se lleve a cabo la operacion de mover. Esta es la forma correcta
de mover archivos ya que evita problemas futuros con referencias y rutas de
compilacion.

e Change Method Signature

S se desea modificar un método marcado es posible usar esta opcion en lugar de
hacerlo manualmente. Hay que colocar €l cursor dentro del método cuya marca se desea
cambiar. Esta es una forma rapida de cambiar la visibilidad, € tipo de retorno, los
pardmetros y su orden. Los nuevos parametros se afiaden pulsando el botén "Add" y se
modifican pulsando en botén "Edit".
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& Change Method Signature @
Access modifier:  Return type: Method narme:
|pub|ic hd I ?_void | main |

| Parameters | Exceptions

Type ' Name | Defauttvale  |[ acd
String[] args £ :

T T EI
| |

|

[¥]Keep original method as delegate to changed method
[(Imark as deprecatad

Method signature preview

public static void mwain(String[] args, int argo)

Preview = l [ Ok l [ Cancel

Figura29: Modificar método marcado

e Pull Up and Push Down

Si la clase actual extiende o es extendida por otra clase, puede ser interesante mover
algunos elementos a la superclase (pull up) o a la subclase (push down)
respectivamente. Seleccionar €l elemento y la opcion adecuada llevara a cabo esta
operacion de forma automatizada.

3.6.6 Consultar la Documentacion

La documentacion Javadoc del cédigo que se esté actuamente programando puede ser
consultada en tiempo real simplemente colocando € cursor o € puntero del ratdon sobre
el elemento elegido. Para expandir la ventana con esta documentacion basta con pul sar
lateclade funcion F2.

public static weoid maini(String[] args, int argld) |
VQM Ry display = new Displayl():

Press F2' for focus.
zmerr shell = new ghelldisplay):

shell.secText ("ECLIPSE™);

Figura 30: Consultar Documentacion
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También se dispone de una nueva vista de Javadoc ("Window > Show View... > Java >
Javadoc"). Dicha vista muestra la documentacion Javadoc asociada al €lemento sobre el
que esta situado €l cursor.

v public static void main(5tring[] args) {
Integer 2 = myHE}:h.nd("l”J;

Error Log | Tasks | Problems | Properties | Classic Search Search | Console | @ Javadoc £ cal = 0O
Javadoc - Test.myMethod(,.)
~
This method transforms the String parameter into an Integer object B
Parameters:
i a String representing a numeric character
Returns:
an Integer object which contains the number represented by the String

Figura31: Documentacién de JavaDoc

3.6.7 Importar Archivos JAR

Puede ser necesario importar algunos archivos Jar no incluidos por defecto en el JRE
estandar para que e proyecto pueda compilar. Basta con pulsar € boton derecho del
ratdn sobre la carpeta adecuada, elegir "Properties > Java Build Path", seleccionar la
pestafia "Libraries’, pulsar €l botén "Add External Jars" y seleccionar €l archivo ".jar" o
".zip". El nuevo Jar afiadido sera visible en la ventana Package Explorer como un
pequeiio frasco.

& Properties for MUNDO

[ e Fither test [ (b Build path entry is missing: C:/Docurments and
LtP ; Settings,USUARIC/Escritorio/TESIS feclipse/Instaladores

-~ Info i =

- Beaninfo Path (% Source | 2 Projects | B4 Libraries | < Order and Export

- Builders J&Rs and class folders on the build path:

;ava iu!ld F:tT | @ % cam,ibm.emols.emfevent_2.0.0,%20060518_RC1. jar - | [ add 18RS, l
& Java Code Style = |

fE [oa ilz F-m com.ibm.icu_3.4.4.1.jar - C:\Documents and Settingsh,

(F3] H = N

T & - com.joraft jsch_0.1.28.jar - C\Documents and Setting [ Add External JARs. . ]

- Javadaoc Location
Project References

&% netsourceforge.sqlexplorer.dhz_1.0.0.20060829. jar - [
-4 netsourceforae.salexolorer. mysal 1.0.0,20080829, iar
Figura 32: Propiedades

Add Variable. .. l
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3.7.1VISTASDE ECLIPSE

Dos tipos de elementos integran 1o que es la interfaz de usuario: vistas y editores. Los
editores permiten realizar una tarea completa, las vistas proporcionan funciones de

apoyo.

Describiremos las vistas mas interesantes de Eclipse a la vez también describiremos
algunos consgjos de cOmo navegar através de los editores.

3.7.2 Perspectivas

En Eclipse una perspectiva es una agrupacion de vistas y editores de manera que den
apoyo a una actividad completa del proceso de desarrollo software.

Es posible crear perspectivas propias afadiendo nuevas vistas y cambiando su
distribucion en la pantalla. Las perspectivas pueden seleccionarse eligiendo "Window >
Open Perspective" del menu. Las perspectivas son:

& Open Perspective A
| EECYS Repository Explaring

%‘Debug

&1 1ava (default)

T 3ava Browsing

e 1ava Type Hierarchy
v Plug-in Developrment
[P5Resource

P =0l Explorer
£0Team Synchronizing

(64 l [ Cancel

Figura 33: Abrir Perspectiva
Resour ce

Relacionada estrechamente con e sistema de archivos puesto que representa la
localizacion fisica de los recursos almacenados dentro de los proyectos

Java

Centrada en tareas de programacion, mostrando paquetes, clases, métodos y atributos en
sus vistas asociadas.

Plug-in development

Permite alos desarrolladores afiadir nuevos médul os de Eclipse.
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Install/Update

Permite gestion de la configuracion. Muestra los componentes instalados asi como sus
versionesy conflictos.

Debug

Relacionada con la tarea de depuracion. Se centra en |os procesos € ecutados, puntos de
ruptura, variables, salida, etc.

Java Browsing
Permite ojear rapidamente codigo, proyectos, pagquetesy jerarquias.
L osiconos de perspectiva se encuentran en la esguina superior derecha.

Existe un botén etiquetado como "Open a Perspective' que permite acceder
rapidamente a otras perspectivas. Otro cambio es que la perspectiva "Install/Update”’ ha
sido eliminada, y puede accederse a sus funciones seleccionando "Help > Software
Updates".

o (@
%5 Debug

&1 Java

15 Java Browsing

Other...
Figura 34: iconos de Per spectiva.

3.7.1.2 Tareas

La vista de tareas ("Tasks View") permite una répida gestion de tareas pendientes.
Seleccionando "Window > Show View > Tasks' se muestra esta vista. Pueden afiadirse
nuevas tareas haciendo click en e boton "Add task".

Laprioridad de latareay su estado también pueden modificarse sin méas que hacer click
en dichos campos. También los errores y las advertencias de los archivos con codigo
guardados se muestran en esta vista. Haciendo click en la descripcién de un error llevara
hasta el punto exacto del codigo en que se encuentra dicho error.

Dando un click derecho en cualquier punto de la vista de tareas se mostrard un menu
contextual que permitirarealizar de forma rdpida cualquier actividad relacionada con la
gestion de las tareas definidas.
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3.7.1.3 Navigator

Esta ventana del navegador de recursos permite echar un vistazo a la estructura de
archivos de los proyectos definidos.

Esta vista es la Unica que muestra la carpeta de salida ("bin") asi como los archivos Java
compilados (".class").

‘ackage Explorer | Hierarchy 53

= = manual

=] Bﬁ
[1] Clientes. java
5 .classpath
2 .project

Figura 35: Carpeta Bin
3.7. 1.4 Package Explorer

La vista del explorador de paquetes muestra la estructura l6gica de paquetes y clases
Java almacenados en los distintos proyectos.

Las carpetas fuente (que deben almacenar los archivos fuente ".java') se muestran
decoradas con el icono de un paquete contenido. Los archivos Java también pueden ser
expandidos de modo que muestren sus métodos y atributos internos al pulsar €l botén
II+II.

# Package Explorer X NElEEga g {VE]

= = manual
= src
= (default package)
: &[] Clientes. java
&+-E8 JRE System Library [jrel.5.0_09
SRnotas

Figura 36: Estructura légica de paquetes
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3.7. 1L.5Working Set

Un conjunto de trabajo es un grupo de elementos que se muestran en las distintas vistas
de eclipse. Estos conjuntos de trabajo se usan como filtros que permiten separar
claramente los diferentes proyectos en que se esta trabajando.

Esto es muy Util cuando se esta trabajando simultaneamente en varios proyectos no
directamente relacionados entre si. Organizar los distintos proyectos en grupos de
trabajo acelerara €l proceso de buscar los elementos deseados y reducira la confusion
visual.

Para definir un conjunto de trabajo, basta con pulsar en € icono de menu del Package
Explorer (el icono de un tridngulo invertido) y seleccionar "Select Working Set". Aqui
se permitira nombrar un nuevo conjunto de trabajo, asi como seleccionar sus recursos
relacionados y editar o quitar otros conjuntos de trabajo existentes. Todos los conjuntos
de trabgjo disponibles se muestran directamente la proxima vez que se pulse € icono
triangular de men.

gar [T, © O *vundimjava | B proje
= 5 v package com;

h;_ﬂ‘ TLINDIC

&7 (default package)
8 com

Top Level Elements *

Select Working Set...

Figura 37: Nombrar nuevo conjunto de trabajo

Si creamos un nuevo proyecto cuando un conjunto de trabajo esta siendo usado hara que
el nuevo proyecto no se muestre dentro de las vistas de Eclipse. Para poder ver el
proyecto recién creado, sera necesario editar e conjunto de trabajo actual ("Menu de la
vista > Select Working Set > Edit" o directamente "Edit Current Working Set") y
seleccionar €l nuevo proyecto para que se muestre.

3.7. 1.6 Outline View

La vista de resumen es una forma répida de ver qué métodos o atributos se encuentran
definidos dentro de una clase de Java. Los iconos asociados proporcionan informacion
adiciona de acuerdo con la visibilidad del atributo o método en cuestion. Y sblo con
hacer click en cualquiera de estos iconos conducira a la linea de cédigo exacta en que
dicho atributo 0 método esta definido. La vista de resumen es una herramienta esencial
para entender y navegar archivos Java voluminosos.

=im
AR e WY
B com
=@, Mundito
% risin SringlT)

ef mainSiring[])
ef main{String[ ], int)

Figura38: Métodos o atributos definidos dentro de una clase de java.
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3.7. 1.7 Hierarchy View

La vista de jerarquia muestra las relaciones de herencia presentes entre distintos
elementos de Java. Haciendo click derecho en e nombre de una clase Java en e editor
de cddigo y seleccionando "Open Type Hierarchy" abrira esta vista de jerarquia. La
tecla rapida asociada es "F4"

]

"= Hierarchy X
Mundito, working set: Window \Working =~

Figura 39: Vista de Jerarquia

Existe la opcion "Open Call Hierarchy" a menu contextual del editor de cédigo. Tras
seleccionar un método, a hacer click en esta opcidn se abrird una vista que mostrara
ddnde es usado dicho método. Las teclas rapidas asociadas son "CTRL + ALT + H".

Fast Views

Arrastrar una vista hasta el margen izquierdo (hasta que aparezca un icono de carpetas
apiladas) convierte esta vista en una "vista rapida’. Pulsar €l icono de la vista rgpida
har& que dicha vista se muestre, mientras que volver a pulsarlo (o pulsar en cualquier
otro punto de la pantalla) hara que se oculte. Mediante un click derecho en €l icono dela
vistarapiday seleccionando "Fast View" restauraralavistaa su posicion original.

Es un pequefio rectangulo situado en la esquina inferior izquierda de la pantalla. Asi
pues, las vistas répidas se crean ahora arrastrando la vista dentro del rectéangulo hasta
gue aparece un icono de una flecha dentro de un cuadrado. No obstante, la zona en la
que se almacenan las vistas rapidas puede cambiarse de sitio colocando € cursor sobre
ella hasta que se transforma en un cursor con cuatro flechas, arrastrando y depositando
lazonaen el lugar deseado.

m oject &3 |2l classpath b Mundito.class b Ohject.class

undito, working et %~ 11" encoding="UTF-g" 2>
&1 E pa
| B € aEmE>
= © object ments
LC M nditn
nand>
rorg.eclipse. jdt.core. javebuilder</ names
ments>
aments>
@, Mundita
- )
B e lL dito {
B'T §\5 o =ment this method
- 5 ic static void main(String args) {
@ * main(String[ Ty s, 0):
& ® main(String[T)
@ ¥ main(Stringl], int)
in statin vnid wainiSnrinafl arest {

Figurad0: Vistas Réapidas
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3.7.1.9 Search View

Tl

Para realizar una busqueda dentro de Eclipse, € menu "Search" de la barra superior de
menus deberia ser seleccionado. También se pueden lanzar busquedas pulsando el icono
de linterna.

Hay varios tipos de busguedas dentro de Eclipse.

N NCREE P NCR R R R R

= Search

X

“y File Search | B2 13¢5 Search | %7 Plug-in Search
Caontaining text:
. v | [¥] Case sensitive

{* = any sfring, 7 = any c...scape for literals: * 7%y [JRegular expression

File name patterns:

Patterns are separated by a comma (* = any string, 7 = any character)

[Jconsider derived resources

Scope
O workspace Selected resources (O Enclosing projects
®warking set: | manualito ]

@ l Replace... ” Search H Cancel I

Figura 41: Busgueda

e La busgueda de archivos "File Search” es una busqueda textual que puede ser
gjecutada sobre archivos de todo tipo. Es equivalente a una busgqueda tradicional .

e La busqueda de ayuda "Help Search" efectlia busquedas dentro de la ayuda de
Eclipse.

e La busgueda de Java "Java Search” es similar a la busgueda de archivos pero
proporciona funciones adicionales para buscar en archivos Java. Permite buscar
explicitamente por tipos, métodos, paquetes, constructores y campos, usando
restricciones de busgueda adicionales (como por ejemplo, buscar solo € punto
del codigo en que se declararon los elementos coincidentes).

Es importante comprobar que la busgueda se efecttia sobre | os ficheros apropiados. Esto
puede definirse usando el campo "scope”. "Workspace" hace referencia a entorno de
trabajo completo. "Selected Resources' son solo los archivos seleccionados (es posible
seleccionar més de un archivo haciendo click izquierdo en ellos mientras se mantiene

pulsada latecla CTRL). "Working Set" es un conjunto de trabajo previamente definido.
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L os resultados de busqueda se muestran como un érbol jerarquico.

Problems | Javadoc | Declaration | Consale | Tasks m_

w5 Mavigator &2
= =2 MUNDO
-2 cam
|5 .classpath
E .project

Figurad2: Resultados busqueda
3.7.2 Navegar por las Vistasy los Editores

Esto fue una introduccién de cémo utilizar las vistas de Eclipse y como dichas vistas
ayudan amanegjar lainformacion.

A continuacion explicaremos algunas funciones de navegacion adicionales que seran
Gtiles para encontrar rgpidamente la informacion deseada y que permitiran presentarla
adecuadamente en |os diversos editores y vistas.

3.7.2. 1 Maximizar una Vista o Editor

Haciendo doble click en € titulo de una ventana para maximizarla. Doble click en €l
titulo de nuevo hara que las dimensiones y posicion de la ventana sean restauradas a las
que tenia originalmente.

"CTRL + M" como tecla rapida asociada a maximizar o restaurar la ventana del editor
actual.

3.7.2.2Ir al Ultimo Cambio

El icono del menu representado como "una flecha con un asterisco™ sirve para colocar el
cursor en el ultimo punto del cédigo que fue modificado dentro del editor activo. Es
habitual que tras cambiar algo de cddigo (por egemplo, tras escribir algunas
instrucciones nuevas) movamos el cursor a otra linea para revisar otra parte del
programa. Si desearamos volver a punto en que afiadimos el ultimo cambio (que suele
ser el lugar por € que "ibamos programando”) tendriamos el problema solucionado con
solo pulsar esteicono de"ir a Ultimo lugar editado".

L as teclas rapidas asociadas son "CTRL + Q".

- )t:: @ -
1 Objfl ast Edit Location

Figura 43: Ultima ubicacion editada
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3.7.2.3 Acciones de Navegacion de los Editores

Qué se deberia hacer s queremos volver a un punto del programa en € que no
introdujimos ningun cambio (es decir, en €l que situamos €l cursor pero en que no
escribimos o borramos ningun carécter)?

Y s quisiéramos regresar a lugar en que estuvimos justo antes de editar algo en otro
lugar? Las flechas de navegacion del menu resolverén estos problemas. Basta con pul sar
la flecha de "navegar hacia atrés' para regresar a puntos previamente visitados del
programa.

T

- *\';_, | =
b Ot ack o project
Figura 44: Regreso al proyecto

Y pulsando la flecha de "navegar hacia delante" recorreremos el historial de lugares
visitados hacia los puntos mas recientes.

e -al-2| B

|F|:urwar|:| to Main.java|

Figura 45: navegar hacia adelante

De hecho, estas Utiles acciones funcionan de forma muy similar a como lo hacen los
botones de "atras' y "adelante” de un navegador web.

La opcidn de "atras' sdlo se activa s existen puntos de programas que se visitaron
previamente.

La opcién de "adelante”" se activa tras haber pulsado € botén de "atras'. También hay
que tener en cuenta que pulsando en el pequefio tridngulo negro que se encuentrajunto a
las flechas de navegacion desplegaremos un menl que muestra otros archivos (distintos
del abierto en la ventana activa del editor) en los que se encuentran otros puntos
visitados accesibles.

Para cambiar la ventana activa del editor a otras ventanas abiertas existe un método
abreviado: "ALT + F6" (comando de "siguiente editor").

Las Utiles teclas répidas asociadas a estas acciones de navegacion son "ALT +
IZQUIERDA" para navegar hacia atrés y "ALT + DERECHA" para navegar hacia
delante.
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3.7.2.4 Revisar Problemas

Los botones de "Ir a siguiente/anterior problema’ permiten recorrer uno tras otro los
problemas pendientes que aparecen en €l editor actual.

Estos botones de "ir a problema’ se han sustituido por botones de "ir a anotacion".
Haciendo click en el pequefio triangulo negro cercano a estas flechas de navegacion por
anotaciones se abrird una lista editable con los tipos de anotaciones que seran recorridas.

7 e P
Bookmarks
Diff Additiones
Diff Changes

Errors
Info
OCcurrences
Search Results
Spelling Errors
Tasks

v WWarnings

Figura 46: Revisar Problemas
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3.8EJECUTAR Y DEPURAR

Si el programa de Java se encuentra completo sera hora de gecutarlo y probarlo. Quizés
aparezcan algunos "bugs' a la hora de gecutarlo. Entonces sera hora de depurar €l
programa. Eclipse proporciona ayuda a las tareas de gjecutar y depurar codigo.

3.8.1 Ejecutar

Para gecutar un programa dentro de Eclipse hay que seleccionar "Run > Run..." del
menu principal. Dentro de "Configurations' se almacenan diferentes configuraciones de
gjecucion. Hay cuatro tipos de configuraciones de g ecucion:

Java Applet (para applets web)

Java Application (para programas normales de Java)

JUnit (casos de prueba)

Run-Time Workbench (otras instancias de Eclipse que permiten probar nuevos
maodul os de Eclipse).

Configurations:

+-f8 Java Applet

CE-A W 15va Application

+- gy JUnit

+ é Run-time Waorkbench

MNew | |

Figura 47: Ejecutar Depurar

Para gjecutar un programa de Java normal deberia seleccionarse "Java Application” y
pulsar el boton "New" para crear una nueva configuracién. Dentro de la pestafia"Main"
hay que dar nombre a la nueva configuracion seleccionar el proyecto que contiene la
clase con e méodo main y seleccionar dicha clase. EIl método "main" es e punto de
gjecucion de un programa Java, y se representa como un pequefio icono de un hombre
corriendo al lado del icono delaclase.
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MNarme: _._Mundih:___(})__

mﬁk Arguments | B JRE | % Classpath | 5+ Source | B8 Environment | =1 Common
Froject:

s (oo
Main class:

& Select Main Type

Select type (7 = any character, ™ = any Siring, TZ = TimeZat =

Matching types:
[ @ mundits - com

£ com - MUMDO

@ OK ] [ Cancel ]

[ Run l [ Close

Figurad8: Seleccionar un tipo principal

Cuando se desea pasar argumentos al método main (en laforma de "String[] args"), no
hay mas que hacer click en la solapa de "Arguments' y escribir esos argumentos
separados por espacio dentro de la zona en blanco de "Program Arguments’.

® main ©= Arguments

Program arguments:

| arglarg?|
Figura 49: Pasar argumentos al método main

Y para terminar, hacer click en e botdén "Run" lanzara la gecucion del programa
seleccionado. Una forma mas rgpida de arrancar la eecucion del programa
recientemente ejecutado es pulsar en e icono de una flecha blanca dentro de un circulo
verde.

o

3.8.2 Depurar

A pesar de que Java no es tan dificil de depurar como otros lenguajes de programacion,
también es posible que surjan complejos problemas de gecuciéon. Eclipse da apoyo
completo alatarea de depuracion através de su perspectiva "Debug” ("Window > Open
Perspective > Debug" o seleccionando el icono del "bicho" en el margen).
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Dentro de esta perspectiva de depuracion, haciendo click en el margen izquierdo del
editor de codigo aparecerd un menu contextual. Seleccionando "Add/Remove
Breakpoint" afiadira o quitara un punto de ruptura.

"Toggle Breakpoint" cambiara €l estado de activacion del punto de ruptura. Los puntos
de ruptura marcan lineas en que la gjecucion del programa se detendra de manera que
sea posible comprobar €l valor de las variables en ese instante, identificando asi posibles
Errores.

public static void main {String[] args)

int i = 4;

int j F addFive (i) :
Femove Breakpaint println(j}:
Disable Breakpoint

Breakpoint Properties. ..

Add Bookmark. ..
Add Task...

Figura 50: ldentificar posibles errores

Haciendo click derecho en un punto de ruptura y seleccionando "Breakpoint
Properties..." permitira especificar opciones avanzadas del punto de ruptura.

"Hit Count" especifica que la gjecucion del programa se detendré cuando se pase por €l
punto de ruptura el nimero especificado de veces. Las condiciones de activacion
detendran la gecucion cuando la condicion sea cierta o bien cuando el vaor de la
condicién cambie.

Especificar una variable como una condicién de activacion y seleccionar "suspend when
value of condition changes' es una forma de "detener la gecucion en € punto de
ruptura cuando dicha variable sea modificada’.
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£ Java Line Breakpoint Properties

Java Line Breakpoint Properties

Type: ExampleClass
Member: main{String[])
Line Number: 24

I+ Enabled

[+ Enable Hit Count

Hit Count: | 1

Suspend Policy
{* Suspend Thread

(" Suspend VM
[+ Enable Condition (Ctrl+Space for code assist)

Condition: |; » Integer.MAX VALUE

Suspend when

(¥ condition is "true’

" value of condition changes
Figura5l :Ruptura

L as excepciones son uno de |os sintomas més evidentes de errores de gjecucion.

Los "Java Exception Breakpoints' detienen la gjecucion cuando salta una excepcion del
tipo seleccionado. Estos puntos de ruptura se activan haciendo click en el icono "JI" de
lavistade "Breakpoints' o desde el menud principa "Run".

L a gjecucion puede detenerse cuando la excepcion sea capturada, no capturada o ambas.
Afadir sempre los puntos de ruptura de excepciones Java de
" ArraylndexOutOfBoundsException” (lanzada cuando €l indice de una matriz se sale de
sus dimensiones)

"NullPointerException” (lanzada cuando se intenta acceder a una referencia que apunta
anull) es una practica de depuracion recomendada.
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ca = P g Jlg - X

jFeam

=¥l

':a r
ﬂNuIIPDinterExcepﬁn:nn: caught and uncaught
& ExampleClass [line: 24] - main(String[])

= Add Java Exception Breakpoint

Choose an Exception (7 = any character, * = any string)

| ArrayIf‘ExcEpﬁnn“

|G ArrayIndexQutOfBoundsException - java.lang

v Caught
1~ Uncaught

| QK | Cancel

Figurab52: Rupturas

Si se desea que €l programa se detenga en los puntos de ruptura definidos debera ser
giecutado en modo depuracion ("Run > Debug..."). Tras detenerse en un punto de
rupturalaeecuciéon del programa puede continuar de diversas maneras.

Dando un click derecho en el editor de cddigo dentro de la perspectiva de depuracion
aparecerd un menu contextual con estas opciones.

"Run to line" reanuda la gecucién del programa hasta que se acanza la linea en que
estadl cursor.

"Step into selection” continuara la gjecucion dentro del método seleccionado siempre 'y
cuando el codigo fuente del método esté disponible.

La gecucion también puede reanudarse mediante un click derecho en la ventana de
"Debug" y seleccionando las opciones adecuadas, o directamente pulsando los iconos de
dichaventana. "Step over" pararaen lalinea siguiente alainvocacion de un método.

"Resume” reanudara la gjecucion normal del programa y solo se interrumpira en los
puntos de ruptura si sus condiciones de activacion se satisfacen.
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S Step Into
=3 Step Over

Figura53: Editor de Codigo

La vista "Variables" proporciona informacion verdaderamente Util ya que muestra los
valores que tienen actualmente las variables cuando la gjecucion se detiene en un punto
de ruptura.

()= Variables
i java.lang.String[] args=java.lang.String[0] (id=15)
e @ inti= 4 [~0]

Variables |Brealq:oints |Expressions | Display

Figura54: Variables

Lavista de "Debug" también es Util para observar diferentes procesos que estan siendo
€jecutados simultaneamente.

Cuando €l proceso de depuracion ha terminado, |os procesos mostrados en la ventana
de depuracion se muestran como "Finished" (pueden acabarse manualmente con "Click
derecho > Terminate"). La informacion de eecuciones previas puede elminarse
realizando click derecho sobre ella y seleccionando "Terminate and Remove' o
"Terminate All" més "Remove All Terminated".
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3.8.3 Gestion de Cambios

Eclipse proporciona un potente sistema de gestion de cambios y de control de versiones.
Haciendo click derecho en un archivo Java dentro del Package Explorer y seleccionando
"Replace With > Local History" permitira reemplazar la version actual por una version
previamente guardada. La hora y fecha de modificacion se muestran junto con dos
ventanas que destacan |as diferencias existentes entre ambas versiones.

Replace from Local History

m Local History of 'ExampleClass.java’

= @E‘ Today (25-ago-2004)
©
0 12:23:42
+| |7_:|'9 Yesterday (24-ago-2004)
+ @ 23-ago-2004
+ |T_:|‘I‘} 22-ago-2004

protected int intProtected;
public int intPublic:

protected int intProtected;
public int intPublic;

public static void main({String[] args| public static void main(String[] g L0
int i = 4; int i = 5; [
int j = addFive{i)}:
System.out.println(j); H
T * (non-Javadoc)
* @see java.lang.Object#finalize
/* [non-JdJavadoc) ' "
< - » ¢ | T

|I| Java Source Compare 4 4
ExampleClass.java (0 Local History (25-ago-2004 17:05:00)
~
private int intPrivate; private int intPrivate;
int intPackage; int intPackage; =

Replace |

Cancel

Figura55: Resumen de Modificaciones

Seleccionando "Window > Preferences > Workbench > Local History" permitir4
seleccionar cuantas versiones, megas y dias amacenar. Asi pues, se puede obtener un
buen equilibrio personalizado entre seguridad y eficiencia.
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£ Preferences

=| Workbench Local History
Appearance
Compare,Patch Days to keep files: | 31
+- Editors
External Tools Entries per file; | 100

File Aszodations
Fonts
Keys
Label Decorations Note: The Entries per file and Days to keep files values are only applied on Workbench restart,

Maximum file size (MB): | 2

Linked Resources
Local Histary
Perspectives

Search
Ctarhim

Figura56: Preferencias

3.90PTIMIZACION DE LA HERRAMIENTA ECLIPSE
3.9.1 DESCARGA E INSTALACION DE PLUGINS

El Framework Eclipse es un entorno altamente extensible a través de plugins. Los
mismos que van aportando nuevas prestaciones a entorno, volviéndolo més efectivo a
la hora de crear aplicaciones.

3.9.2VISUAL EDITOR

En este caso elegimos hablar acerca del “Visua Editor” de Eclipse, un conjunto de
herramientas que permite diseflar “GUIS’ Interfaces Gréficas de Usuario utilizando
componentes Swing o SWT, tales como botones, cuadros de texto, etiquetas, etc; esto se
puede realizar directamente tan solo arrastrando |os objetos hacia un formulario para no
tener que hacerlo Unicamente mediante cédigo.

El propésito de Visual Editor es promover el uso de la plataforma Eclipse afiadiendo
capacidades y servicios; este a igual que Eclipse pertenece ala comunidad “Open
Source”.

Para que Visual Editor funcione debemos instalar:

e Emf runtime (Eclipse Modeling Framework)
e GEF runtime (Eclipse Graphical Editing Framework)
e VE runtime (Visua Editor)

Si se descargan cada uno de estos directamente de la pagina de Eclipse se debe tomar en
cuenta el obtener una version que funcione correctamente con la version de Eclipse
instalada.
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En nuestro caso descargamos las versiones:

e Emf runtime 2.3.0
e GEFruntime3.2.1
e VEruntimel.2.0

Después de esto lo Unico que debemos hacer es descomprimir estos archivos en la
carpeta donde hayamos instalado Eclipse.

Callipso

En la version de Eclipse que estamos utilizando 3.2.1 viene instalada una herramienta
que nos facilita mucho la actuaizaciéon de los plugins, esta se llama Callipso y nos
permite a través del menu de Eclipse encontrar estas actualizaciones; es importante
consultar que version de las actualizaciones se gjusta a la versién gue estamos
utilizando, el proceso de descarga de actualizaciones utilizando Callipso se realiza de la
siguiente manera:

Seleccionamos en e Menl Help—> Software Updates—> Find and Install.

S =
i) Welcome

{%) Help Contents
?%"' Search
Dynamic Help
Key Assist,.. Ctrl+5hift+L

Tips and Tricks. ..
Cheat Sheets...

[ Sooetpim ]2 Frdand .

About Edipse SDK §"; Manage Configuration
¥ About SQL Explorer I

Figura57: Ruta de Acceso para descarga de actualizaciones
L uego de esto se nos desplegara una pantallay seleccionamos esta opcion:

(=) Search for new features to install

Select this option if you want to install new features from existing or new update sites. Some sites may already be
available. You can add new update site URLs to the search.

Figura 58: Opcion para descarga de actualizaciones
Para descargar los plugins lo haremos seleccionando de entre todos:

%] Callisto Discovery Site
Figura59: Sitio de donde se puede descargar las actualizaciones

Inmediatamente nos mostrara esta pantalla, en la cual se esta estableciendo la conexion
con “Callisto Discovery Site”.
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Update Manager
\p Operation in progress. ..

(@an ]

[Run in Eackground] [ Cancel ] [ Details »> ]

Figura 60: Pantalla que muestra el progreso dela conexion al sitio

Después a elegir € sitio de donde vamos a descargar |as actualizaciones nuevamente
seleccionamos “ Callisto Discovery Site”.

Luego se mostrara una pantalla donde podremos elegir las actualizaciones necesarias:

Select the features to install:

[=-[+] 000 Graphical Editors and Frameworks e
Ui visual Editor 1.2.1.v20060817_M-2XJUBOFM-0vSd:
= [®]000 Java Development
j %} Eclipse Java Development Tools 3,2, 1.r321_v20060305-R4CM1Znkyvredw
: .:fi Edlipse Plug-in Development Environment 3.2, 1.r321_v200&0823-ov¥LLdC
.-ﬁi Visual Editor 1.2, 1,+20060817_M-zXJUBOfxM-0vSdc
|:|={‘|.:’= J2EE Standard Toals {15T) Project 1.5, 1.v200608111510-4kW-0_zxPud7G
E-[]000 Models and Model Development =
[&-[]000 Testing and Performance >
< | >

Figura 61: Pantalla con €l listado de actualizaciones disponibles

Damos click en siguiente y ahora tendremos que aceptar os términos legal es:

{®) il acceptthe terms in the license agreement;
Figura 62: Opcién para aceptar lostérminos legales

Después de esto las actualizaciones sel eccionadas empiezan ya a descargarse.

& Update Manager

Flgura63 Barrade progr e I dwcarga de actualizaciones
Una vez descargados |os nuevos componentes, solo quedainstalarlos:

Y por ultimo nos indica que debemos reiniciar la aplicacion para que los cambios sean
realizados.
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USO DEL VISUAL EDITOR

Para este gemplo lo primero que haremos es crear dentro de Eclipse un “Java Project”
con € nombre de “Prueba VE”, de igual manera que se reaizé anteriormente en este
capitulo.

El siguiente paso serd crear dentro del Proyecto que creamos un elemento del tipo
“Visua Class’, esto |o podemos encontrar en File > New - Visual Class.

& New Java Visual Class
Java Visual Class ®
Source folder: i_‘PruEha VE |
Package: | | (default) | Browse...
[ClEndlosing type:
Mame: E_JFLam_El -
Modifiers: (%) public () defauit

[abstract [ final
Style:

(= RCP #| Superdass: é‘javax.swing.JFrame Browse. ..
-2 W - N
. Interfaces:
Swing
(= Other
‘Which method stubs would you fike to create?
public static void main(String] aras)
[ Constructors from superdass
Inherited abstract methods
* | Do youwant to add comments as configured in the properties of the current project?
£ | > [[] Generate comments

Figura64: Pantalla de creacion de un elemento “ Visual Class”

Ya una vez dentro lo que hacemos es escribir el nombre del elemento y ademas
seleccionar €l estilo que llevara nuestra clase, para €l gemplo seleccionaremos €l estilo
JFrame dentro del APl Swing de Java, aunque también podemos elegir otros como
Applet e incluso elementos del APl SWT de Java.

Style:
| & Swing ™
BEH applet
.'f Application
:=|_1II_, Desktop Pane
= Dialog
O
Ig Internal Frame
|_| Panel
B_.’f Scroll Pane
||_| Split Pane
B Tabbed Pane
71 window
£ |

Ml
Figura6b: Lista de seleccidn del estilo del elemento “ Visual Class’

Luego de esto damos click en Finish y se crea el elemento, entonces podremos apreciar
en pantalla las diferentes partes que conforman € Visual Editor de Eclipse, como son:
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- En la Figura 66 se muestra donde podemos ver la Barra de Herramientas de
Visual Editor, que tiene controles de seleccion, otros para hacer y deshacer los
cambios, ademés €l boton de Pausa, etc.

& m| L [i&- © =- BARRADEHERRAMEENTAS
e i VISUAL EDITOR

Figura 66: Barra de Herramientas del Visual Editor

- Tenemos también la Figura 67 donde podemos ver primero La Paleta de
Controles de donde se puede arrastrar componentes y soltarlos en la parte de la
interfaz donde o deseemos (Drag & Drop).

- La Vista de Disefio, aqui se muestra la Interfaz que estamos creando en el
momento y donde colocaremos |os controles que deseemos para la aplicacion
gue estamos creando.

- LaVistade Codigo, en este lugar se ira colocando autométicamente el codigo de
la ventana y de los componentes que vamos incluyendo; y ademéas de esto
podemos escribir todo el codigo extra que necesitemos para que nuestra
aplicacion funcione de la manera que deseamos.

- La Vista de Propiedad es donde después de dar click sobre e control a que
gueremos modificar las propiedades y después dependiendo del tipo de control
se pueden modificar ciertas caracteristicas como: tamafo, color de fondo, tipo de
letra, tamarfio de letra, etc.

- Algo importante a destacar es que cuando el Boton de Pausa de la Barra de
Herramientas suspende la sincronizacion entre la Vista de Codigo y la Vista de
Disefio, en este momento en lugar de Pausa se activa el boton de Reload y tan
solo se puede hacer cambios en el Codigo, y en e momento que se considere
necesario se da un click para que ambos Cddigo y Disefio vuelvan a estar
sincronizados.
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=

0 =Framelijava X
g8 JFrame

private JPanel getdContentPane () {
if (jContentPane == nmll} {
jContentPane = new JPanel();
jContentPane.setlLayout (nmll) ;
¥
return jContentPane;

| — Palette — i
| [% Selection
| El Marquee
| & Choose Bean
Ji5 Swing Compon, ., #
= TButton
[+] JCheckBox
' JRadioButton
[ TToggleButton
%= JLabel
{1 TextField
{5l JPasswordField
[ TTextarea
{4 25licer
[0 JScroliBar
[ auist
{5 JComboBax
|E5| TTree
Ef
B obane
EH JTable

f TableColumn
-

| _ﬂ;_Sv._un_g_Cnmam?r_s

60

PALETA DE
CONTROLES

.!;';9 Swing Menus
| "% AT Controls

| Problems | Javador | Dedlaration | = Properties 52 Search | T i:«:::; @ ¥ =0
Property Value i)
background 238,238,238
border
componentOrientation UNKMOWN
enabled true

VISTA
= e ‘ PROPIEDADES

foreground 51,51,51 o

Figura 67: Elementos de la pantalla principal del Visual Editor de Eclipse

Writable Smart Insert 5611

Para el giemplo de cdmo se maneja el Visua Editor vamos a realizar una calculadora,
asi que aparte de la clase Visual que creamos anteriormente, utilizaremos la clase
Calculadora que se detalla a continuacion:

//public class Calculadora {
I

//double numerol;

//double numero2;

Il

[/public Calculadora (double num1, double num2){
1 this.numerol = numi;

1! this.numero2 = num2;

I}

I

//double sumaCal culadora(){

Il double resultado = 0;

Il resultado = this.numerol + this.numero2;
1 return resultado;

I}

I

//doubl e restaCal culadora(){

1 double resultado = O;

1 resultado = this.numerol - this.numero2;
I return resultado;

I}

I

//double multiplicaCal culadora(){

1! double resultado = O;

1 resultado = this.numerol * this.numero2;
1! return resultado;

I}

I

//doubl e divideCal culadora(){

Il double resultado = 0;

1 resultado = this.numerol / this.numero2;

1! return resultado;
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In
I

En la Figura 68 se muestra que para configurar algunas de las propiedades como set
Layout o titulos de las ventanas, columnas de una tabla o una etiqueta, se lo puede
realizar tan solo dando click derecho sobre € control y eligiendo la opcion deseada.

ﬁi‘ < Undo Typing crl+z | u E@

Open
Open With 4
Open Type Hierarchy

=| Copy

Rename Field

— Events N

Customize Layout...

Figura 68: Ejemplo de modificacion de propiedades de un control

Dentro de la paleta de controles podemos seleccionar 10 que necesitemos para nuestra
interfaz como pueden ser Botones, Labels, Text Fields, Tablas, Combo Box, Check
Box, etc.

T=—palette — V|
[ Selection
[_1 Marquee
@’@ Choose Bean
._l. 1

‘/ JICheckBox
(+ JRadioButton
" TToggleButton
) JLabel

[ TTextField

{&= JPasswordField
L5 JTextArea

7 Jslider

(€10 IScrollBar

[H st

15 IComboBox
|E5| TTree

EEf| TTable on
=
JscrollPane

[ ITable
B TableColumn
w

-!; Swing Containers
,;,13 Swing Menus
At

#y AWT Controls
Figura69: Paleta de eleccion de controles de Visual Editor

Para nuestro g emplo necesitaremos 3 Labels o Etiquetas, 3 Text Fields y 4 Botones
puesto que el resultado a cual queremos llegar es el que se muestraen laFigura 70:
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CALCULADORA

NUMERO 1
NUMERO 2

L) L] Lea] L |

RESULTADO

Figura70: Modelo de I nterfaz del ejemplo de Visual Editor

Luego de colocar € control que deseemos sobre la interfaz nos aparecera un cuadro

como €l de laFigura 71 en donde escribiremos el nombre con el cual identificaremos al
control.

& Name fgl

Bean Name

Provide names for beans (6\.3&/

@ = jButton ‘ bsuma| ‘

preferences [ bo not ask again

Figura 71: Creacién de un control en el Visual Editor

@

Una vez colocados los controles que necesitamos para e eemplo, empezaremos a
trabajar con los eventos; para asignar eventos a un control damos click derecho sobre €l

mismo y elegimos alguno de los que se listas ahi y sino elegimos Add Events tal como
se muestraen laFigura 72.

et

Rename Field

# Delete
s

Set Text
Customize Layout...

@4 actionPerformed

@4 enabled

: S text

Figura72: Afadir eventosa un control

Dentro de Add Events se lista una serie de eventos gque por gjemplo pueden dispararse
en el caso de dar un click o al presionar unatecla, o en e momento en el que se enfoca
alguno de los controles; agqui elegimos el evento que queremos programar COmo Se
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muestra en la Figura 73, entonces automaticamente se genera el cédigo de declaracion
del evento y podemos empezar a escribir codigo que permita que € control funcione de
la manera esperada.

& Add Event - bsuma-"( + )"

Add Event page i

- Fowus # | Event fired when the mouse is dicked

[ //’ﬂ Hierarchy

] /"(3 Hierarchy Bounds

£ /"Q Input Method

- “a Item

B-“@ Key

= ""f;) Mouse - MouseAdapter

! % mouseEntered () Create new Listener
@% mouseExited
@% mousePressed
@4 mouseReleased Oimplemenis: java.awt.event.Mouselistener

b )
%@ Mouse Motion |

(=) extends: java.awt.event.MouseAdapter

Figura73: Seleccién de tipo de evento en Visual Editor

El codigo que se genera de manera automatica cuando elegimos un evento es similar en
todos ellos, por gemplo al afiadir el evento suma al botén sumalo que obtuvimos en un
inicio fue lo que se muestra a continuacion, después como se muestra en la Figura 74,
tuvimos que escribir algunas lineas méas para que se sumen los nimeros dentro de la
clase Calculadora, y que el resultado se muestre en e Text Field de resultado:

//bsuma.addM ouseL istener(new java.awt.event.MouseAdapter() {

1 public void mouseClicked(java.awt.event. MouseEvent €) {

i System.out.printin(*mouseClicked()"); // TODO Auto-generated Event stub mouseClicked()
) }

1),

o wmeor ]

NUMERO2 - } i

::| = ‘ :‘ = | | {.x.].|: | o ‘

RESULTADO |- i

=
bsuma.addMouselistener (new java.awt.event.Mouselidapter() { ~ 8
public wvoid mouseClicked(java.awt.event.MouseEvent e) {
String cadnuml, cadnumZ;
cadnuml = nltext.getText();
cadnum? = n2text.getText ()
if (cadnumi.aquals(""]l

Figura74: Edicion del codigo del evento
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A continuacién se muestra € cadigo fuente resultado del
Framework Eclipse utilizando Visual Editor:

/limport javax.swing.SwinguUtilities;
/limport javax.swing.JOptionPane;
/limport javax.swing.JPanel;
/limport javax.swing.JFrame;
/limport javax.swing.JLabel;
/limport java.awt.Rectangle;
/limport javax.swing.JTextField;
/limport java.awt.Font;

/limport javax.swing.JButton;
/limport java.text.Decimal Format;

I

[Ipublic class Framel extends JFrame {

64

trabajo realizado en el

1 private static final long seriaVersionUID =1L ;

i private JPanel jContentPane = null;

I private JLabel nllabel = null;

1! private JLabel n2label = null;

1 private JTextField nltext = null;

1! private JTextField n2text = null;

1! private JLabel redabel = null;

1! private JTextField restext = null;

1 private JButton bsuma = null;

1 private JButton bresta= null;

1 private JButton bmulti = null;

i private JButton bdivi = null;

1

1 private JTextField getN1text() {

1 if (nltext ==null) {

1l nltext = new JTextField();

1 nltext.setBounds(new Rectangle(211, 21, 144, 26));
1 nltext.setFont(new Font("Didog", Font.BOLD, 14));
1 }

1 return nitext;

1 }

1

1 private JTextField getN2text() {

1 if (n2text ==null) {

1 n2text = new JTextField();

1 n2text.setBounds(new Rectangle(212, 64, 144, 26));
1 n2text.setFont(new Font("Diaog", Font.BOLD, 14));
1 }

1! return n2text;

1 }

1l

1 private JTextField getRestext() {

1 if (restext == null) {

1 restext = new JTextField();

1 restext.setBounds(new Rectangle(233, 174, 129, 33));
1 restext.setFont(new Font("Dialog”, Font.BOLD, 18));
1

1 return restext;

1 }

1l

1 private JButton getBsuma() {

1 if (bsuma==null) {

1 bsuma = new JButton();

1 bsuma.setBounds(new Rectangle(38, 122, 72, 31));

1 bsuma.setFont(new Font("Diaog", Font.BOLD, 18));
1 bsumasetText("( +)");

1 bsuma.addM ouselL istener(new java.awt.event.MouseAdapter() {
1l public void mouseClicked(java.awt.event. MouseEvent €) {
1l System.out.printin("mouseClicked()");

1 String cadnuml, cadnum2;
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65

cadnuml = nltext.getText();

cadnum?2 = n2text.getText();

if (cadnuml.equals("")|lcadnum2.equals(""))
{

JOptionPane.showM essageDial og(null, "DEBE
INGRESAR TODOS LOS DATOS", "ATENCION",
JOptionPane.PLAIN_MESSAGE);

}

else

{
double numerol = 0, numero2 = 0;
double resultado = O;
numerol = Double.parseDouble(nltext.getText());
numero2 = Double.parseDouble(n2text.getText());
Calculadora obj1 = new Calculadora(numerol, numero2);
resultado = obj1.sumaCal culadora();
Decimal Format Digitos = new Decimal Format("0.00");
restext.setText(Digitos.format(resultado));

}

bresta = new JButton();

bresta.setBounds(new Rectangle(147, 122, 72, 31));
bresta.setText("(-)");

bresta.setFont(new Font("Dialog”, Font.BOLD, 18));
bresta.addM ouseL istener(new java.awt.event.MouseAdapter() {

b
}
return bsuma;
}
private JButton getBresta() {
if (bresta==null) {
b
}
return bresta;
}

private JButton getBmulti() {
if (bmulti == null) {

public void mouseClicked(java.awt.event. MouseEvent €) {

System.out.printIn("*mouseClicked()");
String cadnuml, cadnum2;

cadnuml = nltext.getText();

cadnum?2 = n2text.getText();

if (cadnuml.equals("")||cadnum2.equals(""))

{

JOptionPane.showM essageDial og(null, "DEBE
INGRESAR TODOSLOS DATOS", "ATENCION",
JOptionPane.PLAIN_MESSAGE);

}
else
{

double numerol = 0, numero2 = 0;

double resultado = O;

numerol = Double.parseDouble(nltext.getText());

numero2 = Double.parseDouble(n2text.getText());

Calculadora obj1 = new Calculadora(numerol, numero2);

resultado = obj1.restaCal culadora();

Decimal Format Digitos = new Decimal Format("0.00");

restext.setText(Digitos.format(resultado));

}

bmulti = new JButton();

bmulti.setBounds(new Rectangle(253, 122, 72, 31));
bmulti.setText("( x )");

bmulti.setFont(new Font("Dialog", Font.BOLD, 18));
bmulti.addM ouseL istener(new java.awt.event.MouseAdapter() {
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1 public void mouseClicked(java.awt.event. MouseEvent €) {

1 System.out.printin("mouseClicked()");

1 String cadnuml, cadnum2;

1 cadnuml = nltext.getText();

1 cadnum2 = n2text.getText();

1 if (cadnuml.equals("")||cadnum2.equals(""))

i {

1 JOptionPane.showM essageDial og(null, "DEBE

INGRESAR TODOS LOSDATOS", "ATENCION",
JOptionPane.PLAIN_MESSAGE);

i }

I else

) {

1 double numerol = 0, numero2 = 0;

1 double resultado = O;

1 numerol = Double.parseDouble(nltext.getText());

1 numero2 = Double.parseDouble(n2text.getText());

I Calculadora obj1 = new Calculadora(numerol, numero2);

I resultado = obj1.multiplicaCalculadora();

1 Decimal Format Digitos = new Decimal Format("0.00");

1 restext.setText(Digitos.format(resultado));

) }

I }

1 b

I }

I return bmulti;

I }

i

1 private JButton getBdivi() {

) if (bdivi == null) {

1 bdivi = new JButton();

1 bdivi.setBounds(new Rectangle(353, 122, 72, 31));

I bdivi.setText("(/)");

1 bdivi.setFont(new Font("Dialog", Font.BOLD, 18));

1 bdivi.addM ouseL istener(new java.awt.event.MouseAdapter() {

I public void mouseClicked(java.awt.event. MouseEvent €) {

I System.out.printin("mouseClicked()");

1 double numerol = 0, numero2 = 0;

1 double resultado = O;

1l numerol = Double.parseDouble(nltext.getText());

1 numero2 = Double.parseDouble(n2text.getText());

1 String cadnuml, cadnum2;

1 cadnuml = nltext.getText();

i cadnum?2 = n2text.getText();

1 if (cadnuml.equals("")||cadnum2.equals("")|jnumero2==0)

) {

1 JOptionPane.showM essageDial og(null, "DEBE
INGRESAR TODOSLOS DATOS Y 2DO NUMERO
DEBE SER DISTINTO DE CERO", "ATENCION",
JOptionPane.PLAIN_MESSAGE);

I }

I else

) {

1 Calculadora obj1 = new Calculadora(numerol, numero2);

1 resultado = obj1.divideCal culadora();

1 Decimal Format Digitos = new Decimal Format("0.00");

1 restext.setText(Digitos.format(resultado));

I }

I }

1 b

I }

I return bdivi;

) }

)

1 public static void main(String[] args) {

1 SwingUltilities.invokelL ater(new Runnable() {

1 public void run() {



FLORES—-MONTERO 67

1 Framel thisClass = new Framel();

1 thisClass.setDefaultCloseOperation(JFrame.HIDE_ON_CLOSE);
i thisClass.setVisible(true);

i }

1 b

) }

I

1l public Framel() {

1" super();

1 initialize();

i }

i

1 private void initialize() {

1 this.setContentPane(getJContentPane());

I this.setTitle("CALCULADORA");

1 this.setBounds(new Rectangle(0, 0, 475, 260));

i }

)

i private JPanel getJContentPane() {

1 if (jContentPane == null) {

1 reslabel = new JLabel();

1 reslabel.setBounds(new Rectangle(95, 180, 127, 24));
1 reslabel .setFont(new Font("Dialog”, Font.BOLD, 18));
I reslabel .setText("RESULTADQO");

1 n2label = new JLabel();

1 n2label .setBounds(new Rectangle(105, 62, 84, 29));
1 n2label .setFont(new Font("Dialog", Font.BOLD, 14));
i) n2label .setText("NUMERO 2");

I nllabel = new JLabel();

1 nllabel.setBounds(new Rectangle(105, 19, 84, 29));
1 nllabel.setFont(new Font("Dialog”, Font.BOLD, 14));
I nllabel.setText("NUMERO 1");

1 jContentPane = new JPanel();

1 jContentPane.setL ayout(null);

1 jContentPane.add(nllabel, null);

1 jContentPane.add(n2label, null);

1 jContentPane.add(getN 1text(), null);

1 jContentPane.add(getN2text(), null);

1 jContentPane.add(reslabel, null);

1l jContentPane.add(getRestext(), null);

1l jContentPane.add(getBsuma(), null);

I jContentPane.add(getBresta(), null);

I jContentPane.add(getBmulti(), null);

1 jContentPane.add(getBdivi(), null);

I }

1 return jContentPane;

) }

I

- EnlaFigura 75 estala Vista Java Beans, donde se lista los controles que fueron
utilizados para el ggemplo, junto con |os eventos que se manegaron.
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%g JavaBeans i |
E=2i=0-
= [ this-"CALCULADORA™
=2 |_| jContentPane
#5 nlabel-NUMERO 17
5 n2label-NUMERQ 27
I nitext
1 n2text
§8 reslabel-"RESULTADO"
I | restext
== bsuma-"{ +)"
% mouseClicked
== bresta-"(-)"
2% mouseClicked
== bmulti-"(x )"
@ moyseClicked
== bdivi-"( /)"
@4 mouseClicked

Figura 75: Vista Java Beans de Visual Editor

Y por ultimo la Figura 76 muestra el resultado final de esta aplicacion.

B CALCULADORA =3
NUMERO1 (1533
NUMERO2  20.12

i L] Lea] L

RESULTADO |[35.45

Figura76: Resultado Final dela Calculadora

Cabe destacar que este gemplo pudo haber sido realizado sin necesidad de utilizar la
clase calculadora, pero |0 consideramos necesario para demostrar que aparte de trabajar
con eventos, se puede seguir trabgando normalmente utilizando clases y objetos que
son labase del Lenguaje Java.

3.9.3 BIRT (BusinessIntelligence and Reporting Tools)

Otro de los plugins de Eclipse que nos parecio interesante es el BIRT que sirve para
crear reportes de nuestra BD, ya que la informacion que estos pueden proveer seria de
mucha ayuda para una empresa.

Para poder utilizar BIRT se debe instalar |0 siguiente:

e BIRT 211

o Eclipse3.2.1
e GEF321

e« EMF230

« JRE16.0

Todo esto se puede encontrar para descarga en la pagina de Eclipse www.eclipse.org,
para descargar e BIRT vamos a la pagina principa de este proyecto
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www.eclipse.org/birt/ y damos click en el boton “Download BIRT”, esto nos enviara a
la zona de descarga del mismo, en donde dice “Cose a Designer Download” damos
click en “Framework”, en la pagina que sigue elegimos €l sitio de donde deseamos
descargar el BIRT, obteniendo €l archivo:

birt-report-framework-2.1.2.zip

Después de esto tan solo necesitamos descomprimir €l archivo en el directorio donde se
encuentra Eclipsey listo, g ecutamos el Framework y podemos empezar a utilizarlo.

USO DE BIRT
Para este gemplo lo primero que hicimos fue crear una BD en MySQL Server 5.0

[lamada “birt” donde creamos una tabla de Clientes e ingresamos algunos registros en la
misma, a continuacion se muestrala estructura de latablay su contenido:

CLIENTES

CAMPO TIPO NULL PK
cli_cedula varchar(10) | NO PRI
cli_nombre varchar(80) | NO
cli_direccion | varchar(80) | NO
cli_telefono varchar(12) | NO

cli_mail varchar(40) | NO

Datos Existentes al momento del gjemplo:

CLIENTES

cli_cedula cli_nombre cli_direccion cli_telefono cli_mail
JOSE FRANCISCO

0301928438 | MONTERO FLOR AV. DON BOSCO 2819625 carowpooh@hotmail.com
CAROLINA ISABEL

0104636824 | FLORES CORONEL PUERTAS DEL SOL | 2452060 jofranm18@hotmail.com

Abrimos Eclipse, y mientras nos encontramos en la perspectiva original del mismo
creamos un nuevo proyecto en laruta File > New - New Project.

Una vez aqui dentro crearemos un Proyecto para reportes tal y como se indica en la
siguiente figura Business Intelligence and Reporting Tools = Report Project,
aunque se podriatrabajar creando |os reportes dentro de un proyecto de Java; bueno una
vez seleccionado esto damos click en Next y en el siguiente paso escribimos el nombre
gue tendra nuestro proyecto que sera REPORTE.
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& New Project @

Select a wizard

Creates a new Report Project. |

<

Wizards:
| type filter text

ﬁ Java Project
# Java Project from Existing Ant Buildfile
‘:fé Plug-in Project

(= General

[=)-[= Business Inteligence and Reporting Tools

&

= Cvs

(= Edipse Modeling Framework

= Java

[ Plug-n Development

®

Figura 77: Creacién de Nuevo Proyecto

Después de escrito € nombre damos click en Finish y nos saldrd una pantalla en donde
nos pregunta s queremos cambiar a la perspectiva Report Desing que es donde
crearemos nuestro reporte, elegimos si y se cambia automaticamente a la perspectiva;
otraforma de realizar esto es mediante el botdn “ Open Perspective’ que se encuentra en
la parte superior derecha de la pantalla con lo que se desplegara la pantalla que se
muestra a continuaci on que nos permitira cambiar de perspectiva:

& Open Perspective @

%CHS Repository Exploring
#@Debug

?,JJava {default)

5_1 Java Browsing

EJJava Type Hierarchy
==Plug-in Development

2 Report Design |
[EResnurce

| sQL Explorer

gDTeam Synchranizing

|_ OK J [ Cancel

Figura 78: Open Perspective
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Lo siguiente que haremos sera crear una nueva hoja de reporte en la siguiente ruta de la

barra de menu File 2 New = Report, agui lo asociaremos al proyecto gue creamos y
escribimos su nombre “ Clientes.rptdesign”.

& New Report [E|
New Report

Create a new report

Enter or select the parent folder:
| REPORTE

[ REPORTE

)

I Next = J[ Finish H Cancel

Figura79: Creacion de Reporte

Al dar click en Next podremos elegir crear un reporte nuevo (Blank Report) o algin
model o predefinido, elegimos Blank Report y presionamos Finish.

A continuacién se muestra la perspectiva Report Design con todos sus componentes:
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€ Report Design - Clientes.rptdesign - Eclipse SDK NEE
Fle Edit Insert Page FElement Data Navigate Search Project Run Window Help
S [mae @- Qi R | MR v 5 | 12 Report Design | &7 7ava
 Paette 2 . DataExplorer | Lbrary Explorer| = O | [ et e e =0
[, Rectangle Select
[=-Report Items ||
b Label
AE Text
ab] Dynamic Text
E Data
Gl Tmage
F @rid
B st
£ Table -
[l Chart oy
5. Navigator 52 . Outiine = Ol
B% |-
= I~ REPORTE )
[El project i ] ] . ] [
[& Clientes.rptdesign Layout | Master Page | Script | XML Source | Preview
5= Property Editor - Report 52 . Problems B =0
" Properties |
Properties: General
loeneal | &
| Description Author: [ |
| Comments
| User Properties Createdby: | Ecipse BIRT Designer Version 2.1.2.v20070205-1728 Build <20070205-1728> |
|mamed Expressions
|Event Hander Path: | cH\EEMPLOS BIRTIREPORTE \Clientes rptdesian | -
|Resources -
Titke: [ |
Units: [in ~| -

e

Figura80: Perspectiva Report Design

El componente mas importante es la pantalla donde disefiaremos € reporte, en la parte
baja de esta esta una serie de botones que nos permitiran tener una vista previa del
reporte “Preview”, ver e codigo XML del reporte “XML Source” y e principal
"Layout” parapoder disefiar €l reporte.

Debajo de la ventana de Disefio se encuentra la ventana de propiedades donde se podran
cambiar algunas caracteristicas de |os elementos que pongamos en |a hoja de reporte.

En la parte superior izquierda se pueden encontrar dos pestafias también importantes,
“Palette” de donde seleccionaremos y arrastraremos |os componentes a la ventana de
disefio de manera similar a como se trabajaba en Visual Editor; la otra pestafia es “Data

Explorer” donde configuraremos las conexiones y generaremos consultas para
utilizarlas en el reporte.

Ahora seleccionamos la pestafia “Data Explorer” y damos click derecho sobre “Data
Sources’ y elegimos New Data Source del menu contextual.

En la pantalla que se despliega elegimos de la lista “JDBC Data Source” para poder
utilizar la base de datos de MySQL y damos click en Next con lo que se mostrara una

pantalla como la siguiente donde configuraremos la conexion a la BD, aqui escribimos
lo siguiente:
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& New JDBC Data Source Profile

Create a new data source

Create a new data source

Driver Class: com.mysgl.jdbc. Driver (v3.0) vJ

Database URL: | jdbcimysgl: /flocalhost/birt

User Name: | root |

Password: | T |

INDIURL: | |
’ﬂanage Drivers... ] ’Iest Connection...

@ I Finish J ’ Cancel

Figura 81: Configurar Conexion

Luego dentro de “Data Explorer* damos clic derecho ahora sobre “Data Sets’ y
elegimos New Data Set.

Ahora en la nueva pantalla en Data Set Name escribimos un nombre para el conjunto de
datos, en este caso Clientes, en Data Source elegimos lo que acabamos de crear, por
ultimo en Data Set Type elegimos SQL Select Quero y damos click en siguiente.

Se nos desplegard una pantalla donde podremos escribir en base a la informacién
almacenada en la tabla una consulta, para el g emplo la consulta que utilizaremos es:

SELECT clientes.cli_cedula, clientes.cli_nombre, clientes.cli_direccion, clientes.cli_telefono, clientes.cli_mail
FROM clientes
ORDER BY 2

Luego a partir de los datos que obtuvimos podremos crear un reporte utilizando los
componentes de la Paleta, a final la vista de Layout de nuestro reporte quedd de la
siguiente manera, para esto se utiliz6 un elemento lista, una tabla, varios labels y
ademés arrastramos de nuestro Data Set |as columnas que queremos que se muestren.

El [ Header

REPORTE DE CLIENTES

[chi_cedula]

[cli_nombre]

[chi_direccion]
[cli_telefono]
EMAL I

Bl § Footer

Figura 82: Layout del Reporte
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Y por ultimo al elegir Preview podremos ver € resultado del reporte que creamos y
ademas si damos click derecho sobre la pantalla podremos enviarlo aimpresora.

REPORTE DE CLIENTES

CEDULA: 0104636824
INOMBRE: CAROLINA ISABEL FLORES CORONEL
[DIRECCION: PUERTAS DEL SOL

LEFONO: 2452060

ERYNTE N - o'pooh@hotmail com

CEDULA: 0301928438

SV 1 OSE FRANCISCO MONTERO FLOR
DIRECCION:- ~ ENSvON: e

2819625

OV N ;of: 2nm1 8 @hotmail com

Mar 22, 2007 2:20 AM
Figura 83: Vista Preliminar del Reporte

3.10 CONCLUSION

Eclipse es un editor de cddigo, de uso facil, se compila de una forma rdpida, €l entorno
es amigable. Esta herramienta de desarrollo es una pieza clave para la calidad y
productividad de un proyecto.

Eclipse es totalmente extensible, es decir se pueden fabricar plug-ins (desarrollo a parte
de la plataforma de eclipse que aporta una determinada funcionalidad) o utilizar los que
ya estén desarrollados.

Eclipse es una estructura (workbench) que puede soportar distintas herramientas de
desarrollo y paracuaquier lenguaje.
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CAPITULO 4: APLICACION PRACTICA

4.1 PROBLEMA

Un pequefio restaurante requiere un sistema de control de cuentas de gastos de sus
clientes que debera ser utilizado por €l cgjero del restaurante.

Cada cliente debe poder hacer un depdsito inicial que le dara crédito para consumir 1os
productosy servicios del restaurante.

La compra solo se debera efectuar si hay crédito suficiente en la cuenta del cliente para
el débito en cuestion.

L as cuentas se manejaran de acuerdo atres estados:

ABIERTA: Al momento de abrir una cuenta €l valor minimo en la acreditacién es de
$5. En este momento se puede disponer de los productos a su el eccion.

CERRADA: Lacuenta se cambiara a este estado, en el momento en el que el mismo
cliente asi o desee. Y en el caso de existir saldo se procedera a respectivo reembol so.

CRITICA: La cuenta cambiara de estado de abierto a critico autométicamente, cuando
después de una operacion de débito el saldo sobrante se detecte inferior o igual a $1, en
este caso existen dos opciones: a cliente se le puede reembolsar su saldo o e mismo
puede volver a acreditar un nuevo valor siempre y cuando sea este mayor o igual a $5.

Todos los movimientos que los clientes realicen en sus cuentas, como abrir, cerrar,
reabrir, debitar o acreditar, quedaran registrados.

Para una mayor comodidad de los clientes, se contara con un terminal de consulta; el
mismo que les servird para realizar sus propias consultas sobre su cuenta o sus datos
personales.

Notas:

e Los datos de los clientes se podréan eliminar solo en € caso de que la cédula de
identidad esté incorrecta, con esto se eliminardn autométicamente también las
cuentasy los saldos para que puedan volver a ser ingresados correctamente.

e Losclientes podran disponer de varias cuentas.
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ANALISISDE LA APLICACION.

DIAGRAMA DE CASO DE USO

Un caso de uso representa una funcionalidad del sistema que utiliza un actor,
siento actor un tipo de usuario que desempefia una funcion dentro del sistema. El
diagrama de caso de uso se basa en las funcionalidades del sistemay en e actor

DIAGRAMA DE CASO DE USO

!-'j t': Realizar
I::D {Movimientos ]N
CAJERO
“Localizar Cta.Cliente”
Consultar ﬁ
it =

YVamos a crear dos escenarios

4.2
421
gue las utiliza.
CLIENTE
\d

* para situaciones diversas:

Escenario 1: El Cajero elige hacer un
“movimiento de debito” a partir de la cuenta
corriente del cliente y efectla la transaccion.

Escenario 2: El Cajero elige hacer un
“movimiento de débito" de la cta.cte del
cliente, pero, no habiendo saldo suficiente,
la transaccién no se efectla.

Figura 84: Casos de Uso
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4.2.2. DIAGRAMA DE OBJETOS

CUENTA
T 1 bcuenta

cli_cedula 2dula

cli_nombre stado

cli_direccion cue_rtecha

C| i_te | efOWGasa Diagrama de objetos

cli mail ingresarCue
43 DISENO DE LA APLICACION modificarCuent:

En nuestro proyecto ' contara con dos aplicaciones diferb(k@,ca rCuentas
figreeeang

una de ellas sera util por €0 del restaurante, en esta se podra mangjar ptpscarCuenta:

del cliente, cuentas y bascasledi@Rt®a a ser utilizada exclusivamente por los
clientes para sus consHﬁ; a]ﬁl@étfae H%Cﬁf@rsonal €S 0 cuentas. uscarCuentas:

. ) buscarCue
DICCIONARIO DE eAmamarCliente

buscarNun
Tabla Columna Descripcion Tipo Tam L.Iave. Llave
Primaria | Foranea
CLIENTES cli_cedula Cédula del Cliente varchar |10 |si no
CLIENTES cli_nombre Nombre del Cliente varchar (80 |no no
CLIENTES cli_direccion Direccion del Cliente varchar |80 |no no
CLIENTES cli_telefono Teléfono del Cliente varchar |12 |no no
CLIENTES cli_mail Mail del Cliente varchar |40 |no no
CUENTAS cue_nocuenta No. De cuenta int 6 Si no
CUENTAS cue_cedula Cédula del Cliente varchar |10 |no si
CUENTAS cue_estado Estado del la cuenta varchar |7 no no
CUENTAS cue fecha Fecha date no no
SALDOS sal_nocuenta Numero de Cuenta int 6 no Si
SALDOS sal saldo Saldo de la Cuenta double 8,2 [no no
TRANSACCIONES | tra_notransaccion | NUmero de Transaccion | int 10 |no no
TRANSACCIONES |tra_nocuenta Numero de Cuenta int 6 no si
TRANSACCIONES |tra_tipo Tipo de Cuenta varchar |7 no no
Fecha de la

TRANSACCIONES | tra_fecha Transaccion date no no
TRANSACCIONES |tra_valor Valor de la Transaccion | double [8,2 |no no
TRANSACCIONES |tra_saldo Saldo de la Cuenta double |8,2 |no no
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431 REALIZACION DE LA APLICACION RESTAURANTE

Contamos con un menu principal en el cual se procedera aelegir laopcion de clientes.

MENU PRINCIPAL B3 MENU PRINCIPAL

CLIENTES | CUENTAS CLIENTES | CUENTAS |
Ingresar Cliente Abrir Cuenta
Modificar Cliente Cerrar Cuenta
Efiminar Cliente Reabrir Cuemta
Consuitar Cliente Debitar Saldo
Acreditar Saldo
Consultar Cuenta
Consultar Transacciones de la Cuenta

Figura86: Aplicacion —-MeniPrincipal Clientes Figura 87: Aplicacion-Menu Pricipal Cuentas

CLIENTES

B3 INGRESO DE CLIENTES

CEDULA DE IDENTIDAD |

NOMERE | |

DIRECCION | |

TELEFONO | |

MAIL | |

GRABAR

Figura88: Aplicacién —I ngreso Clientes

Seingresaran los datos del cliente como cédula, nombre, direccion, teléfono y mail.

MODIFICACION DE CLIENTES

CEDULA DE IDENTIDAD BuscaR || Nuevo |
NOMBRE |CAROLINA ISABEL FLORES CORONEL |

DIRECCION |PUERTAS DEL 50L |

TELEFONO 2452060 |

MAIL |car0wp00h@h0tmail.c0m |

MODIFICAR

Figura89: Aplicaciéon -Modificacion Clientes
Se modificarén los datos del cliente en caso de haber sido mal ingresados basandose en
el nimero de cédula.
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B2 CONSULTA DE CLIENTES

CEDULA DE IDENTIDAD

NOMBRE

DIRECCION

TELEFONO

MAIL

b |
LIMPIAR

Figura90: Aplicacién — Consulta de clientes
Se consultaran los datos basandose en e nimero de cédula

ELIMINACION DE CLIENTES

CEDULA DE IDENTIDAD | BUSCAR | | NUEVO |
NOMERE |.JOSE FRANCISCO MONTERO FLOR |

DIRECCION |AV. DOM BOSCO |

TELEFONO |281 9625 |

MAIL |j0franm1 S@hotmail.com |

ELIMINAR

Figura9l: Aplicacién —Eliminar clientes
Para eliminar un cliente se lo hace através de la cédulay autométicamente se eliminan
todos sus datos y sus cuentas.

CUENTAS
ABRIR CUENTAS |:||i,l|z|
NUMERO DE CUENTA
CEDULA DE IDENTIDAD (0104636824 |
SALDO INICIAL [a0] |

GRABAR

Figura 92: Aplicacion — Abrir Cuenta
Se procedera a abrir una cuenta, este nUmero se incrementa automéaticamente, se pide la
cédulaal clientey seingresael saldo inicial e mismo que tiene que ser mayor a$5
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CERRAR CUENTAS

CEDULA DE IDENTIDAD

NUMERO DE CUENTA

CUENTA CERRADA, SU REEMBOLSO ES DE 200.0

CERRAR CUENTA |

Figura 93: Aplicacion —Cerrar Cuenta
Mediante la cédula de identidad y el nUmero de cuenta se procede ala blsgueday sela

cierra, reembolsandole el sobrante de su saldo.

B REABRIR CUENTAS

CEDULA DE IDENTIDAD

NUMERO DE CUENTA

SALDO DE REAPERTURA 35

REABRIR. CUENTA

BUSCAR CUENTA

Figura 94: Aplicacion —Reabrir Cuentas
Con el saldo y el nimero de cuenta se procede a reabrir una cuenta siempre 'y cuando €l

saldo a ser acreditado sea mayor a $5

DEBITAR SALDO

CEDULA DE IDENTIDAD

NUMERO DE CUENTA

ESTADO

SALDO

VALOR A DEBITAR |15]

REALIZAR DEBITO

[_BuSCARCUENTA |

Figura9ds: Aplicacién —Debitar Saldo

Solo se podra debitar de la cuenta con el nimero de cédulay el nimero de la cuentay
siempre y cuando no se quede el saldo restante con un valor menor o igual a $1.

80
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ACREDITAR SALDO Eh‘j [5__< |

CEDULA DE IDENTIDAD !

CUENTA !

NUMERO DE CUENTA

ESTADO

SALDO

VALOR A ACREDITAR !5

REALIZAR CREDITO

Figura96: Aplicacién —Acreditar Saldo
Se puede acreditar cuando €l cliente o desee en un estado abierto u obligatoriamente
cuando el saldo este en estado critico es decir igual 0 menor a $1.

B MENU PRINCIPAL
CONSULTAR

Consultar Cliente
Consultar Cuenta

Consultar Transacciones de la Cuenta

Figura 97:Aplicacién-Menu Consultas

Muestra el nombre del cliente y los datos de la cuenta.
La siguiente consulta nos muestra mediante la Cl y el nimero de la Cta., el nhombre del
cliente, el estado, lafecha de apertura, y € saldo
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CONSULTA DE TRANSACCIONES DE CUENTA

CEDULA DE IDENTIDAD

NUMERO DE CUENTA
NOMBRE DEL CLIENTE

| BUSCARCUENTA |

| NUEVO

FECHA VALOR TIPQ SALDO

Mar 22, 2007 200|ABRIR 200
Mar 22, 2007 45DEBITO 155
Mar 22, 2007 155[CERRAR 0
Mar 22, 2007 55[REABRIR 55

Mediante la cédula de identidad, podemos consultar todas las transacciones que han

Figura 98:Consulta de Transacciones

sido realizadas por una persona.

[ CONSULTA DE CUENTAS

CEDULA DE IDENTIDAD

NOMBRE DEL CLIENTE

NUMERO DE CUENTA

ESTADO

FECHA DE RPERTURA

SALDO

Figura 99: Aplicacion —Consulta Cuentas
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A continuacién se detallara la parte que corresponde a los REPORTES, dentro del
entorno de Eclipse podremos acceder a un Reporte que generamos utilizando BIRT, la
siguiente imagen muestra el Layout del mismo:
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REPORTE DE CUENTAS

E B Header
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B [F] Detail

CLIENTE

[ch_cedula]
[cli_nombre]
NUMERO CUENTA ESTADO CUENTA SALDO CUENTA
[cue_nocuenta] [cue_estada] [sal_saldo]

B [E] Footer

Figura 100: Aplicacion — Layout Reporte

Por dltimo mostraremos la vista preliminar del reporte que creamos, en e cua se
muestra la cédula y el nombre de cada cliente y una lista de todas las cuentas que
pertenecen a este cliente con su estado y su saldo:

REPORTE DE CUENTAS

CLIENTE

0104636824
CAROLINA ISABEL FLORES CORONEL

NUMERO CUENTA ESTADO CUENTA

SALDO CUENTA
1000004 ABIERTA 40
1000005 ABIERTA 50
CLIENTE
0104636824
JOSE FRANCISCO MONTERO FLOR
NUMERO CUENTA ESTADO CUENTA SALDO CUENTA
1000002 CERFADA 0
1000003 ABIERTA 333

Mar 22, 2007 232 AM
Figura 101: Aplicacion — Vista Preliminar Reporte
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CAPITULO S

CONCLUSIONES

Eclipse es una herramienta muy potente y totalmente gratuita para desarrollo Java,
creada por Eclipse.org en sociedad con IBM vy otros proveedores de productos para
Java, puede funcionar en varios sistemas operativos como Windows, Linux, Solaris.

Cuando se estan desarrollando proyectos es importante poder utilizar una herramienta
de desarrollo, que conozcan todos los desarrolladores, esto hara que aumente la
productividad, puesto que s es un entorno de desarrollo como Eclipse viene con
wizards (asistentes) que ayudan en la codificacion, tiene detectores de errores que hace
que el cbdigo desarrollado sea de mayor calidad o permite compartir codigo entre un
grupo de desarrolladores. Eclipse puede integrar varios productos en un anico entorno,
gue para la gente que esta empezando es mucho mas sencillo de utilizar. Todo esto hace
que los tiempos de desarrollo sean menoresy por consiguiente |os costes también.
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CAPITULO 6

RECOMENDACIONES

Partiremos en primera instancia del andliss del entorno java para posteriormente
enfocarnos en la Herramienta Eclipse.

Para el caso de Java:

En cuanto a sistema operativo no existe ningun problema, debido a que existen
versiones paracasi todos.

Al disefiar una aplicacion web, los minimos requerimientos son: Intel Pentium
de 166Mhz, 32 MB de RAM y 125 MB de disco duro. Para propésitos practicos
esto no es factible, debido a que la plataforma se cargard pero no se podra
visualizar nada.

Recomendamos Pentium 111, minimo 256MB de RAM, esto dependera en gran
medida de lacomplgjidad del programa.

Para el caso de Eclipse:

El aplicativo ocupa mas memoria. En cuanto a Sistema Operativo no hay
limitantes puesto que estan disponibles versiones para todos.

Lo primordial estener en cuentala memoria RAM.
Usual mente se sugiere como minimo un Pentium [11 y 256 MB de RAM, pero en

base a nuestro estudio, recomendamos Pentium |1l y a menos 512 MB de
memoria.
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Ant

APIs

CVS

GNU GPL

GUIs’

IDE

JUnit

JRE

J2SE

J2EE

J2ME

JVM

JDK

JVM

OTI

OSGi
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GLOSARIO
Herramienta Open-Source utilizada en la compilacion y creacion de
programas Java.
aplication programming interface (swing awt) conjunto de controles
(concurrent version system) Sistema de Control de Versiones

(General Public License o licencia publica general)
Licencia creada por la Free Software Foundation a mediados de |os 80.

Interfaces Gréficas de Usuario

Entorno Integrado de Desarrollo (Integrated Devel opment Environment)
Herramienta utilizada para realizar pruebas unitarias en Java.
(Jjavaruntime enviroment) entorno olbigatorio parala ejecucion de
programasen java. Compuesto por jvmy por €l conjunto de aPls de j2se
(jvm +apis=jre)

Java2 Standard Edition

Java2 Enterprise Edition

Java Micro Edition

Java Virtua Machine

Java Development Kit

(Java Virtual Machine)

(Object Technology International)

Open Services Gateway initiative (Puerta de Entrada de Servicios)

Su objetivo es el definir las especificaciones abiertas de software que
permita disefiar plataformas compatibles que puedan proporcionar

multiples servicios. Fue pensado principamente para su aplicacion en
redes hogarefias y por ende en lallamada informatizacién del hogar.
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ON]

SWT
SDK

Open Source Initiative

(software development kit) Conjunto de herramientas para compilacion,
documentacion y depuracion de errores de

aplicativos java, estd compuesto por jrey por sus herramientas de
desarrollo.

(Standard Widget Toolkit)

(Software Development Kit)

Conjunto de herramientas para compilacion, documentacién y
depuracion de errores de aplicativos Java. El SDK esta compuesto por
JRE y por sus herramientas de desarrollo.





